Installing and Licensing IDL 5.6
Restricted Rights Notice

The IDL®, ION Script™, and ION Java™ software programs and the accompanying procedures, functions, and documentation described herein are sold under license agreement. Their use, duplication, and disclosure are subject to the restrictions stated in the license agreement. Research Systems, Inc., reserves the right to make changes to this document at any time and without notice.

Limitation of Warranty

Research Systems, Inc. makes no warranties, either express or implied, as to any matter not expressly set forth in the license agreement, including without limitation the condition of the software, merchantability, or fitness for any particular purpose.

Research Systems, Inc. shall not be liable for any direct, consequential, or other damages suffered by the Licensee or any others resulting from use of the IDL or ION software packages or their documentation.

Permission to Reproduce this Manual

If you are a licensed user of this product, Research Systems, Inc. grants you a limited, nontransferable license to reproduce this particular document provided such copies are for your use only and are not sold or distributed to third parties. All such copies must contain the title page and this notice page in their entirety.

Acknowledgments

IDL® is a registered trademark and ION™, ION Script™, ION Java™, are trademarks of Research Systems Inc., registered in the United States Patent and Trademark Office, for the computer program described herein.

Numerical Recipes™ is a trademark of Numerical Recipes Software. Numerical Recipes routines are used by permission.

GRG2™ is a trademark of Windward Technologies, Inc. The GRG2 software for nonlinear optimization is used by permission.

NCSA Hierarchical Data Format (HDF) Software Library and Utilities
Copyright 1988-2001 The Board of Trustees of the University of Illinois
All rights reserved.

NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities
Copyright 1998, 1999, 2000, 2001, 2002 by the Board of Trustees of the University of Illinois. All rights reserved.

CDF Library
Copyright © 1999 National Space Science Data Center
National Space Flight Center

NetCDF Library
Copyright © 1996 Hughes and Applied Research Corporation
This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyrighted by INTERSOLV, Inc., 1991-1998.

Use of this software for providing LZW capability for any purpose is not authorized unless user first enters into a license agreement with Unisys under U.S. Patent No. 4,558,302 and foreign counterparts. For information concerning licensing, please contact: Unisys Corporation, Welch Licensing Department - C15W19, Township Line & Union Meeting Roads, P.O. Box 500, Blue Bell, PA 19424.

Portions of this computer program are copyright © 1995-1999 LizardTech, Inc. All rights reserved. MrSID is protected by U.S. Patent No. 5,710,835. Foreign Patents Pending.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/)

IDL Wavelet Toolkit Copyright © 2002 Christopher Torrence.

Other trademarks and registered trademarks are the property of the respective trademark holders.
Contents

Chapter 1: Introduction ............................................................................................. 9

About Adobe® Acrobat® Reader .............................................................................. 10
Contacting RSI .......................................................................................................... 10
System Requirements ...................................................................................................... 11
IDL 5.6 ...................................................................................................................... 11
    Hardware Requirements for IDL 5.6 ................................................................. 11
    Software Requirements for IDL 5.6 ................................................................. 12
ION 1.6 ..................................................................................................................... 12
    Hardware Requirements for ION 1.6 ............................................................... 12
Web Servers .............................................................................................................. 13
Web Browsers ........................................................................................................... 13
Java Virtual Machines .............................................................................................. 14
Licensing Methods ........................................................................................................ 15
    Demonstration License ....................................................................................... 15
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the License Key</td>
<td>33</td>
</tr>
<tr>
<td>Troubleshooting a Personal Use License</td>
<td>34</td>
</tr>
<tr>
<td>Licensing IDL with a Node-Locked License</td>
<td>38</td>
</tr>
<tr>
<td>Save the License File</td>
<td>38</td>
</tr>
<tr>
<td>Enter the License Key</td>
<td>38</td>
</tr>
<tr>
<td>Troubleshooting a Node-Locked License</td>
<td>39</td>
</tr>
<tr>
<td>Licensing IDL with a Floating License</td>
<td>44</td>
</tr>
<tr>
<td>Set Up the License Server</td>
<td>44</td>
</tr>
<tr>
<td>Configure Clients to Access the License Server</td>
<td>48</td>
</tr>
<tr>
<td>Working with the License Server</td>
<td>50</td>
</tr>
<tr>
<td>Starting and Stopping the License Manager</td>
<td>50</td>
</tr>
<tr>
<td>Removing the License Manager Service</td>
<td>51</td>
</tr>
<tr>
<td>Reclaiming an Unused License</td>
<td>51</td>
</tr>
<tr>
<td>Multiple Applications Using the Same License Server</td>
<td>53</td>
</tr>
<tr>
<td>All Products Using FLEXlm are Installed on the Same Server</td>
<td>53</td>
</tr>
<tr>
<td>Troubleshooting a Floating License</td>
<td>55</td>
</tr>
<tr>
<td>Troubleshooting the License Server Startup</td>
<td>57</td>
</tr>
<tr>
<td>Saving the License File in an Alternative Location</td>
<td>60</td>
</tr>
<tr>
<td>For Windows NT/2000 Systems</td>
<td>60</td>
</tr>
<tr>
<td>For Windows XP Systems</td>
<td>61</td>
</tr>
<tr>
<td>For Windows 98 Systems</td>
<td>61</td>
</tr>
</tbody>
</table>

**Chapter 3:**

**Installing IDL 5.6 for UNIX**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>64</td>
</tr>
<tr>
<td>Before You Begin</td>
<td>64</td>
</tr>
<tr>
<td>Recommended Steps for Installing and Licensing IDL for UNIX</td>
<td>64</td>
</tr>
<tr>
<td>Evaluation Licenses</td>
<td>64</td>
</tr>
<tr>
<td>Personal Use Licenses</td>
<td>64</td>
</tr>
<tr>
<td>Node-Locked or Floating Licenses</td>
<td>65</td>
</tr>
<tr>
<td>Installing IDL for UNIX</td>
<td>66</td>
</tr>
<tr>
<td>System Requirements</td>
<td>66</td>
</tr>
<tr>
<td>Mount the IDL CD-ROM on Your System</td>
<td>66</td>
</tr>
<tr>
<td>Run the IDL Installation Procedure</td>
<td>67</td>
</tr>
<tr>
<td>Unmount the IDL CD-ROM from Your System</td>
<td>70</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

This guide describes how to install and license version 5.6 of the following products:

- **IDL** — This is the standard version of IDL offering full access to all of the software’s features including the ability to run and compile programs.

- **IDL Runtime** — IDL Runtime lets users run IDL applications and other IDL-based programs that have been packaged as IDL .sav files. The IDL development environment and the command line are not accessible when using a Runtime license.
About Adobe® Acrobat® Reader

IDL online manuals (which are installed with IDL) require Adobe Acrobat Reader with Search 3.0 or greater. Acrobat Reader 5.0 with Search (Acrobat Reader 4.0 for IRIX and Tru64 UNIX users) has been included on your IDL CD-ROM in the adobe directory (Windows and UNIX), or in the root directory of the CD (Macintosh).

Windows and Macintosh users can launch the Acrobat installer directly from the CD; UNIX users should extract the contents of the .tar file from the subdirectory corresponding to their operating system and follow the installation instructions included in the README file (or, for IRIX and Tru64 users, in the instguid.txt file).

Note

UNIX and Mac OS X users: Adobe Acrobat Reader with Search 3.0 or greater must be installed on your system to view the online help. The online help systems used in previous versions of IDL have been replaced with an online help system that requires Adobe Acrobat Reader.


Contacting RSI

If you have problems with installing or licensing this software product, contact Research Systems technical support for assistance:

- E-mail: support@RSInc.com
- Phone: (303) 413-3920
- Fax: (303) 786-9909

International customers should contact their local RSI office or distributor for technical support.
System Requirements

IDL 5.6

Hardware Requirements for IDL 5.6

The following table describes the supported platforms and operating systems for IDL 5.6:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Vendor</th>
<th>Hardware</th>
<th>Operating System</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Microsoft</td>
<td>Intel x86</td>
<td>Windows</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel x86</td>
<td>Windows NT</td>
<td>4.0, 2000, XP</td>
</tr>
<tr>
<td>Macintosh</td>
<td>Apple</td>
<td>PowerMac G4</td>
<td>OS X</td>
<td>10.1, 10.2.x†</td>
</tr>
<tr>
<td>UNIX†</td>
<td>Compaq</td>
<td>Alpha 64-bit</td>
<td>Tru64 UNIX</td>
<td>5.1</td>
</tr>
<tr>
<td></td>
<td>HP</td>
<td>PA-RISC 32-bit</td>
<td>HP-UX</td>
<td>11.0</td>
</tr>
<tr>
<td></td>
<td>HP</td>
<td>PA-RISC 64-bit</td>
<td>HP-UX</td>
<td>11.0</td>
</tr>
<tr>
<td></td>
<td>IBM</td>
<td>RS/6000 32-bit</td>
<td>AIX</td>
<td>5.1</td>
</tr>
<tr>
<td></td>
<td>IBM</td>
<td>RS/6000 64-bit</td>
<td>AIX</td>
<td>5.1</td>
</tr>
<tr>
<td></td>
<td>Intel</td>
<td>Intel x86</td>
<td>Linux</td>
<td>Red Hat 7.1††</td>
</tr>
<tr>
<td></td>
<td>SGI</td>
<td>Mips 32-bit</td>
<td>IRIX</td>
<td>6.5.1</td>
</tr>
<tr>
<td></td>
<td>SGI</td>
<td>Mips 64-bit</td>
<td>IRIX</td>
<td>6.5.1</td>
</tr>
<tr>
<td></td>
<td>SUN</td>
<td>SPARC 32-bit</td>
<td>Solaris</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>SUN</td>
<td>SPARC 64-bit</td>
<td>Solaris</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 1-1: Hardware Requirements for IDL 5.6.

On platforms that provide 64-bit support, IDL can be run as either a 32-bit or a 64-bit application. Both versions are installed, and the 64-bit version is the default. The 32-bit version can be run by specifying the `-32` switch at the command line:

```
% idl -32
```
† For UNIX (including Mac OS X), the supported versions indicate that IDL was either built on (the lowest version listed) or tested on that version. You can install and run IDL on other versions that are binary compatible with those listed.

†† IDL 5.6 was built on the Linux 2.4 kernel with glibc 2.2 using Red Hat Linux. If your version of Linux is compatible with these, it is possible that you can install and run IDL on your version.

Software Requirements for IDL 5.6

The following table describes the software requirements for IDL 5.6:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Software Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Internet Explorer 5.0 or higher.</td>
</tr>
<tr>
<td>Macintosh</td>
<td>XFree86 version 4.2 (XDarwin 1.1), and (recommended) OroborOSX window manager, both of which are included on the IDL 5.6 product CD.</td>
</tr>
</tbody>
</table>

Table 1-2: Software Requirements for IDL 5.6

ION 1.6

Hardware Requirements for ION 1.6

The following table describes the supported platforms and operating systems for ION 1.6:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Vendor</th>
<th>Hardware</th>
<th>Operating System</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Microsoft</td>
<td>Intel x86</td>
<td>Windows NT</td>
<td>4.0, 2000, XP</td>
</tr>
<tr>
<td>UNIX†</td>
<td>Intel</td>
<td>Intel x86</td>
<td>Linux</td>
<td>Red Hat 7.1††</td>
</tr>
<tr>
<td>SGI</td>
<td>Mips 32-bit</td>
<td>IRIX</td>
<td></td>
<td>6.5.1</td>
</tr>
<tr>
<td>SUN</td>
<td>SPARC 32-bit</td>
<td>Solaris</td>
<td></td>
<td>8</td>
</tr>
</tbody>
</table>

Table 1-3: Hardware Requirements for IDL 5.6.
† For UNIX, the supported versions indicate that ION was either built on (the lowest version listed) or tested on that version. You can install and run ION on other versions that are binary compatible with those listed.

†† ION 1.6 was built on the Linux 2.4 kernel with glibc 2.2 using Red Hat Linux. If your version of Linux is compatible with these, it is possible that you can install and run ION 1.6 on your version.

**Web Servers**

In order to use ION, you must install an HTTP Web server. ION has been tested with the following Web server software:

- Apache Web Server version 2.0 for Windows, Linux, and Solaris.
- Apache Web Server version 1.3.14 for IRIX. This version is included with the IRIX operating system.
- Microsoft Internet Information Server (IIS) version 4 for Windows NT 4.0 Server, version 5.0 for Windows 2000 Server and version 5.1 for Windows XP Professional.

If you do not already have Web server software, the IDL 5.6 CD-ROM contains the following Apache Web Server software:

- Windows — Version 2.0.40
- Linux — Version 2.0.40
- Solaris — Version 2.0.39
- IRIX — Version 1.3.14

**Note**

For more information on Apache software for your platform, see [http://www.apache.org](http://www.apache.org).

**Web Browsers**

ION 1.6 supports the HTTP 1.0 protocol. The following are provided as examples of popular Web browsers that support HTTP 1.0:

- Netscape Navigator versions 4.7 and 6.0.
- Microsoft Internet Explorer versions 5.5 and 6.0.
Browsers differ in their support of HTML features. As with any Web application, you should test your ION Script or Java application using Web browsers that anyone accessing your application is likely to be using.

**Java Virtual Machines**

ION 1.6 has been tested with the following Java Virtual Machines:

- Sun JVM 1.2, 1.3 and 1.4
- Microsoft JVM 5.x

The following are provided as examples of popular Web browsers that are shipped with the above JVMs:

- Netscape Navigator versions 4.7 and 6.0.
- Microsoft Internet Explorer versions 5.5 and 6.0.

Browsers differ in their support of features. As with any Web application, you should test your ION Java application using Web browsers that anyone accessing your application is likely to be using.
Licensing Methods

Access to IDL and other products from RSI is controlled by a software application that ensures a proper license has been entered on the user’s system. Licensing options include demonstration, evaluation, personal use, node-locked, and floating, each discussed in the following sections.

Demonstration License

Demonstration licenses are the default license provided with RSI software products. These licenses allow you to run limited versions of the software products in seven minute demonstration mode. You do not need to request or enter a license file. For more information, see “Running IDL in Demonstration Mode” on page 18.

Evaluation License

Evaluation licenses are temporary trial licenses allowing access to all IDL features for a specified number of days. Once the evaluation license expires, you will be alerted by a dialog box stating that the application is available only in seven-minute demonstration mode. Contact RSI or your local distributor to purchase a permanent license or to extend your evaluation license.

The following is a sample Evaluation license key that you will receive either by e-mail or fax:

- **Product:** IDL X.X
- **Expiration:** 23-Aug-20XX
- **Key:** ABC123DEF456GHI7-123
- **IDL Major Version:** X.X
- **Package Name:** eval_idl

Personal Use License

Personal use licenses are permanent licenses tied to a single user. After you request a personal use license from RSI or your local distributor, you will receive a license key. Entering and saving the license key on a personal computer enables full functionality of the RSI product for the designated user. A personal use license can be installed on multiple machines for the exclusive use of the designated user.

Personal use licenses are available for the Windows, Macintosh, and PC-based UNIX (Linux) versions of IDL 5.6 only.
Chapter 1: Introduction

Licensing Methods Installing and Licensing IDL 5.6

**Node-Locked License**

Node-locked licenses tie a single software application to a single machine. This method of licensing requires a machine’s unique host ID to be incorporated into a license request file. After a license request is sent to RSI or your local distributor, a license file is returned. Entering and saving the license file enables full functionality of the RSI product on the machine for which you have sent the host ID.

The following is a sample node-locked license key that you will see on your product registration form which you will receive either by e-mail or fax:

```
# Installation Number(s): 000011-70-1
INCREMENT idl idl_lmgrd X.XXX 1-jan-0000 uncounted \
    ABC123DEF456GH1789JK VENDOR_STRING="000011-70-1Floating \
    Windows License" HOSTID=00aabb11ccdd ck=28
INCREMENT wavelet idl_lmgrd X.XXX 1-jan-0000 uncounted \
    ABC123DEF456GH1789JK VENDOR_STRING="000011-70-1Floating \
    Windows License" HOSTID=00aabb11ccdd ck=28
```

**Floating License**

Floating licenses (also known as client/server licenses) allow multiple users to concurrently access IDL. After installing and licensing IDL on the server machine, the license manager, installed along with your IDL software, handles requests for licenses from remote client machines. As the server administrator, you can choose how users access the licenses. You can select to reserve licenses for individuals or groups, or select to allow all users to share access to the licenses. If you have a team of 20 people, and you have purchased IDL with 10 floating licenses, you can select to reserve licenses for certain individuals in the group, or allow all team members to share access to the ten licenses throughout the day.

While both node-locked and floating licenses use a license file or key containing information based on a unique host ID from the machine being licensed, floating licenses additionally require the installation of a license manager.

IDL (with floating licenses) uses the Globetrotter Software FLEXlm license manager. The license manager runs continuously on your system, waiting for a request from a RSI product. When a request arrives, the license manager determines whether the proper license for a requested product is available. If the proper license is present and not already in use, the license manager allows access to the software.

The following is a sample floating license key that you will receive either by e-mail or fax:

```
# Installation Number(s): 000011-70-1
SERVER myserver 00aabb11ccdd 1700
DAEMON idl_lmgrd C:\RSI\IDLXX\BIN\BIN.x86\IDL_LMGRD.exe
```
The main difference between a node-locked and floating license is that a floating license contain SERVER and DAEMON lines. The license server should be installed and run on the server indicated in the SERVER line of the license key.
Running IDL in Demonstration Mode

If you want to run IDL for demonstration purposes, you can do so either from the CD-ROM or after installation.

Running from the CD-ROM

To run IDL in demonstration mode from your IDL CD-ROM, complete the following steps:

Windows

1. **Insert the IDL CD-ROM in your CD-ROM drive.** After a short delay, the IDL autorun program starts. If the autorun program does not start automatically, select **Start → Run.** In the Run dialog, type `x:\DEMO`, where `x` is the name of your CD-ROM drive, and click **OK.**
2. **Start IDL.** Select **Start IDL** from the IDL autorun program. The Demo Mode dialog appears.
3. **Click OK.** This starts IDL in seven-minute demonstration mode.

UNIX and Macintosh

The UNIX and Macintosh CD-ROMs do not support this capability.

Installing and Running

To install and run in demonstration mode, complete the following steps:

Windows

1. **Install IDL.** See “Installing IDL for Windows” on page 25. If you wish to run IDL only in unlicensed demonstration mode, select **No** when the Product Licensing dialog appears.
2. **Start IDL.** Click the Windows **Start** button, and select **Programs → Research Systems IDL 5.6 → IDL.** The Demo Mode dialog appears.
3. **Click OK.** This starts IDL in seven-minute demonstration mode. IDL will automatically start in demonstration mode until licensed.
UNIX and Macintosh

1. **Install IDL.** See “Installing IDL for UNIX” on page 66 or “Installing IDL for Macintosh” on page 74.

2. **Set up and run IDL.** See “Setting Up Your Environment” on page 80. IDL will start in demonstration mode which allows you to run a seven-minute session.

**Tip**
Try running the IDL Demo Applications that illustrate some of the many ways IDL can help visualize data. See “Running the IDL Demo Applications” on page 20 for more information.
Running the IDL Demo Applications

The IDL Demo Applications are a series of IDL programs that illustrate some of the many ways IDL can help you visualize data.

Note
If you have already started IDL, you can just type in DEMO at the IDL command prompt.

IDL> DEMO

From the IDL CD-ROM (Windows Only)

To run the IDL Demo Applications from your IDL CD-ROM:

1. **Insert the IDL CD-ROM in your CD-ROM drive.** After a short delay, the IDL autorun program starts. If the autorun program does not start automatically, select **Start → Run.** In the Run dialog, type `X:\DEMO`, where `X` is the name of your CD-ROM drive, and click **OK.**

2. Select **IDL Demo** from the IDL autorun program.

From your IDL Installation

To run the IDL Demo Applications from an installed version of IDL:

**Windows**

Click the Windows **Start** button, and select **Programs → Research Systems IDL 5.6 → IDL Demo.**

**UNIX or Macintosh**

- From the UNIX prompt enter `idldemo` or `idlde` and then type `demo` at the IDL prompt.

**Note**
If `idldemo` or `idlde` do not work, you need to set IDL environment aliases. See “**Setting Up Your Environment**” on page 80.

Running the IDL Demo Applications
Chapter 2: Installing and Licensing IDL 5.6 for Windows

This chapter covers the following topics:

- Introduction ......................... 22
- Installing IDL for Windows ............. 25
- Requesting a License .................. 29
- Licensing IDL with an Evaluation License . 32
- Licensing IDL with a Personal Use License 33
- Licensing IDL with a Node-Locked License 38
- Licensing IDL with a Floating License . . 44
Introduction

Before You Begin

If you’re installing on Windows NT, Windows 2000 or Windows XP, you must have Administrator privileges to install. Additionally, a user with Administrator privileges must be the first one to start a session of IDL in order for the configuration to be complete.

If you do not have such privileges, the installation process cannot modify the system configuration of the machine and it will fail. After you have installed IDL, you do not need Administrator privileges to run IDL on Windows NT, Windows 2000 or Windows XP.

Recommended Steps for Installing and Licensing IDL for Windows

The steps required to install and license IDL depend upon the type of license you will be using. RSI recommends you use the following steps when installing and licensing IDL.

Evaluation Licenses

The following steps are recommended when installing and licensing IDL using an evaluation license:

1. **Install IDL** — See “Run the IDL Installation Procedure” on page 25.

2. **Request a License** — You may have already received an evaluation license key by e-mail or fax. If you haven’t received it, contact your RSI sales representative to request an evaluation license.

3. **Enter Your License Key** — See “Licensing IDL with an Evaluation License” on page 32.

Personal Use Licenses

The following steps are recommended when installing and licensing IDL using a personal use license:

1. **Install IDL** — See “Run the IDL Installation Procedure” on page 25.
2. **Request a License** — You may have already received your personal use license key by e-mail or fax. If you haven’t received it, contact your RSI sales representative to request an evaluation license.

3. **Enter Your License Key** — See “Licensing IDL with a Personal Use License” on page 33.

### Node-Locked Licenses

The following steps are recommended when installing and licensing IDL using a node-locked license:

1. **Install IDL** — See “Run the IDL Installation Procedure” on page 25.

2. **Request a License** — You may have already received your RSI product license information by e-mail or fax. It provides your product installation number and additional information about licensing your product. If you haven’t received it, see “Requesting a License” on page 29 to create a license request.

3. **Enter Your License Key** — See “Licensing IDL with a Node-Locked License” on page 38.

### Floating Licenses

The following steps are recommended when installing and licensing IDL using a floating license:

1. **Install IDL on the License Server** — Install the network license server on the machine you have designated to run the license manager. You can accomplish this by running the IDL installer on your server machine and deselecting every option except the **IDL Program Files** and **Network License Server** features.

   **Note**

   Carefully consider the machine you have chosen as your server machine before saving your license file and starting the license manager. Since “client” machines will be sending requests for licenses to the “server” machine, the ability of client machines to access the license manager software depends on the reliability of the server machine. Therefore, the machine chosen as the server must be one that has a history of reliable operation and one that is running most of the time.

2. **Request a License** — You may have already received your RSI product license information by e-mail or fax. It provides your product installation number and additional information about licensing your product. If you
haven’t received it, see “Requesting a License” on page 29 to create a license request.

3. **Enter Your License Key** — See “Licensing IDL with a Floating License” on page 44.

4. **Start the License Manager** — See “Start the License Server” on page 46.

5. **Install IDL on Your Client Machines** — See “Run the IDL Installation Procedure” on page 25.

6. **Configure the Client Machines** — Configure the client machines so that they can access the license manager, see “Configure Clients to Access the License Server” on page 48.
Installing IDL for Windows

This sections describes system requirements, recommended steps for installing and licensing IDL, and installation instructions for IDL 5.6 on Windows platforms.

System Requirements

The following are the system requirements for IDL 5.6 for Windows:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>150 MB (minimal recommended disk space for a default installation).</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.</td>
</tr>
<tr>
<td>Network Interface Card</td>
<td>A network interface card (NIC or Ethernet) is required for software-based</td>
</tr>
<tr>
<td></td>
<td>node-locked and floating licensing.</td>
</tr>
<tr>
<td>Browser</td>
<td>Internet Explorer 5.0 or higher.</td>
</tr>
</tbody>
</table>

*Table 2-1: IDL 5.6 Windows System Requirements*

Run the IDL Installation Procedure

To install IDL 5.6, complete the following steps:

**Note**

If you haven’t used this type of installer before, you may be required to restart your computer during the installation process. To avoid losing unsaved information, save all open files and close any open applications before installing IDL.

If you are prompted to reboot after installation, you will need to run the licensing wizard to license IDL by selecting **Start → Programs → Research Systems IDL 5.6 → License**.

1. **Insert the IDL CD-ROM in your CD-ROM drive.** After a short delay, the IDL autorun program starts. If the autorun program does not start automatically, select **Start → Run**. In the Run dialog, type `x:\DEMO`, where `x` is the name of your CD-ROM drive, and click **OK**.
2. **Start the IDL installation process.** Click **Install IDL** from the IDL autorun program. Then click **Next** to start the installation wizard.
3. **Accept the license agreement.** After reading the license agreement, select Accept to continue the installation.

4. **View the IDL Release Notes.** The release notes contain important information about this release of IDL. Click Next after viewing the IDL Release Notes file.

5. **Complete the Customer Information form.** Enter the following:
   - Your **User Name** (the name with which you log on to your system).
   - Your **Organization** (the name of your company, department., etc.).

   For Windows NT, 2000 and XP only, select one of the following for **Install this application for**:
   - Install the application for all users on this computer (**Anyone who uses this computer**), allowing any user to log on and access IDL.
   - Install the application as **Only for me** (**User Name**) which displays an IDL Start menu shortcut only when you log on.

   Click Next to continue.

6. **Choose the destination folder.** In the Destination Folder dialog, select the directory in which to install IDL. The default installation directory, which is the disk on your computer with the greatest amount of free space, is displayed. To install IDL in a different location, click Browse. In the Choose Folder dialog, select an alternate location, and click OK.

   The installation directory will be referred to as the RSI-DIR for the remainder of the installation and licensing instructions.

   Click Next to accept the directory that is displayed.

7. **Select the features to install.** In the Custom Setup dialog, the typical installation features are pre-selected and indicated by the hard drive symbol. Clicking on a feature displays information about that option. To add the feature to your installation, click the red “X” and select to install the feature on your hard drive. To remove a feature from your installation, click the hard drive symbol and select the red “X”.

   **Note**
   If you are installing this version of IDL on the machine you have designated as the license server for floating licenses, you must select the **Network License Server** feature. You can deselect any features except the **IDL Program Files** feature. Only a Windows NT, 2000 or XP machine can be used as a **license server** for floating (client/server) licensing.
8. If you are installing ION Java, you will be prompted to enter your Web server’s default directory containing HTML files to automatically copy the necessary ION Java files to the Web server directory. This directory is often called htdocs (on the Apache Web server) or wwwroot (on the IIS Web server). For the Apache Web Server, the path to this directory might be similar to:

   c:\Program Files\Apache Group\Apache2\htdocs

Enter the path and click Next to continue.

If you have installed a previous version of ION Java and have an existing IONJava directory within the htdocs directory, it will be renamed to IONJava.backup.

9. If you are installing Ion Script, the Web Server Configuration dialog will prompt you for the location of your Web server’s CGI executables directory. For example:

   C:\Program Files\Apache Group\Apache2\cgi-bin

Enter the location and click Next to continue.

Note
If you leave this field blank because you have not yet installed a Web server, you will need to manually copy ion-i.exe and ion-p.exe from the ion_script/cgi-bin directory to the CDI executables directory of your Web server after it has been installed.

10. In the second field of the Web Server Configuration dialog, specify the fully qualified domain name and path to the CGI executables directory for your Web server. For example:

   myhost.mydomain.com/cgi-bin

Enter the domain name and path, and click Next to continue.

Note
If you leave this field blank because you have not yet installed a Web server, the installer will use your Windows machine name and the path to your CGI executables directory will be assumed to be /cgi-bin. In order to access ION over the Internet once you have installed your Web server, you will need to update the Image Server, Data Server, and ION Script Parser URLs on the URLs tab of the ION Script Configuration utility (Start → Programs → Research Systems ION 1.6 → ION Script Configuration) to use the fully qualified domain name and the proper path to your Web server’s CGI.
executable directory. For more information, see Chapter 1, “Configuring ION Script” in the ION Script User’s Guide manual.

11. **Begin the installation.** Select **Next** from the Start Copying Files dialog.

12. **Select to License IDL.** To license IDL now, click **Yes**. See the following for more information:
   - “Licensing IDL with an Evaluation License” on page 32
   - “Licensing IDL with a Personal Use License” on page 33
   - “Licensing IDL with a Node-Locked License” on page 38
   - “Licensing IDL with a Floating License” on page 44
   To license IDL at a later time, or to run IDL only in seven-minute demonstration mode, click **No**.

13. **Select to Install Adobe Acrobat Reader.** The Install Adobe Acrobat dialog appears after you exit the licensing wizard.

   IDL online manuals require Acrobat Reader with Search 3.0 or greater. Select **Yes** to install Adobe Acrobat Reader 5.0 if you have not previously installed version 3.0 or greater.

14. **Click Finish.** Your installation is now complete.

**Note**

On Windows NT, 2000 and XP, the first user to start a session of IDL must have Administrator privileges.

**Tip**

To Modify or Repair your installation, insert the IDL CD-ROM and click **Install IDL** from the IDL autorun program. From the Program Maintenance dialog, you can Modify the installed components, or Repair your installation.
Chapter 2: Installing and Licensing IDL 5.6 for Windows

Requesting a License

If you are licensing with a node-locked or floating license, you need a permanent license file from RSI or your distributor. The license file is created using information from the machine on which you have installed IDL. A built-in licensing program has been created to simplify the request and installation of your license file.

Note
You do not need to use the licensing wizard to request a license if you are using a personal use or evaluation license. The required information will be sent to you automatically.

Note
The electronic request program will not be able to retrieve the correct information if you do not have a configured network interface card and do not meet one or more of the following network protocols:

Windows NT/2000/XP — Requires that either the NETBEUI Transport Protocol, the NW Link (IPX/SPX) Transport Protocol, or the SNMP service be installed on your system.

Windows 98 — Requires that either the NETBEUI Transport Protocol or the NW Link (IPX/SPX) Transport Protocol be installed on your system.

Preparing a License Request

The licensing wizard allows you to easily generate and send a license request. The request contains information necessary for RSI to generate your license key. If you have exited the installation program, access the licensing wizard by selecting Start → Programs → Research Systems IDL 5.6 → License.

Note
If you have purchased a floating license, the licensing wizard must be run from the designated license server machine on which you have installed IDL. This ensures proper generation of the server LMHostid and Hostname for your license file.

1. Begin the license request process. Click Permanent from the Product Licensing dialog.

2. Prepare a Request file. Click Request to prepare a license request file to submit to RSI. The licensing wizard guides you through the creation of a
license request file that will contain all the information necessary for RSI to create a valid license file for your software installation.

3. **Enter your information.** Fill in the following text fields in the Permanent Licensing dialog:
   - **Contact Person** — Enter the name of the person to whom the license file should be sent.
   - **Email Address** — Enter the e-mail address of the contact person.
   - **Installation Number** — Enter the installation number found on the RSI Product Registration Form. You should have already received this form by e-mail or fax. If you have not received the form, contact RSI technical support. See “Contacting RSI” on page 10 for more information.
   - **Site Notice** — Enter the name that you want to appear when you launch the software. The name you select will replace <your site notice> in the following statement: “licensed for use by <your site notice>.” This is typically your company’s name, department, or project.

4. **Select the license type.** Select either **Node Locked** or **Floating**. The license wizard automatically generates the correct Hostname and LMHostid. Do not modify these values.

5. **Enter comments.** Enter any comments you may have.

6. Click **Next** to continue.

7. **Review your license request.** If the information is correct, click **Next** to save the license request file and proceed. If the information is incorrect, edit it in the text window or click **Back** to make any corrections.

8. **Send the license request file.** Click **Next** to send the license request file to RSI. If you did not purchase your software directly from RSI, modify the e-mail address and send the file to your local distributor.

**Note**

If you can’t send e-mail from your machine or if you receive a message stating that an attempt to send the e-mail was unsuccessful, see “Manually Sending a License Request” on page 31. A license file will be generated and sent to you at the e-mail address or fax number you supply.

9. **Exit the license wizard.** Click **Finish** to exit the license request program.
If you do not receive a license file or any confirmation that the request was received, see the section below to manually re-send the request. To contact RSI, see “Contacting RSI” on page 10.

**Manually Sending a License Request**

To manually send a license request, select the appropriate step below and e-mail your request to register@RSInc.com or fax the request file text to RSI at (303) 786-9909. If you did not purchase IDL directly from RSI, send the file to your local distributor.

- **From the license wizard** — Select Back to display the request file. Copy all of the request information into an e-mail message or fax this text to RSI.

- **Outside of the license wizard** — Copy the request file, located in $RSI-DIR/license/rsi_request.txt$, where $RSI-DIR$ is the directory where you have installed IDL, and send it by fax or e-mail. If necessary, transfer the file to another machine that can send e-mail.
Licensing IDL with an Evaluation License

After installing IDL, use the licensing wizard to install the license key for your evaluation license. If you do not have a license key, contact your RSI sales representative to request an evaluation license.

1. **Start the licensing wizard.** If you have exited the installation program, access the licensing wizard by selecting `Start → Programs → Research Systems IDL 5.6 → License`.

2. **Access the Evaluation Licensing dialog.** Select the **Evaluation** button on the Product Licensing dialog.

3. **Enter your license information.**
   - Select the **Product** — select the product you wish to license from the drop-down list. Only installed products are displayed.
   - Enter the **Expiration date** — for example, 12-Oct-2000.
   - Enter the **license Key** — enter the key exactly as it appears and click **Next**.

4. **Exit the Licensing wizard.** Click **Finish**.

IDL is now licensed. After your trial period expires, a message appears stating this fact when you start IDL and until re-licensed, IDL will operate only in seven-minute demonstration mode.

**Troubleshooting Evaluation Licensing**

If you receive an error message, locate it below for suggestions on resolving the problem.

1. **The license information does not pass the checksum test.** Carefully check to make sure you have entered your license information exactly as it appears in your RSI product license information. Exactly duplicate capitalization, spacing and the date format as shown on your form.

2. **The file already exists.** If you have an existing evaluation license for this product, you will be asked if you want to replace it. Select **Yes** to overwrite the old license with the new, extended evaluation license.

3. **The file cannot be written.** You may not have write permissions for the directory or the file to which you are attempting to write. Check the permissions to make sure neither the directory nor any files you are attempting to overwrite are designated as “read-only.”
Chapter 2: Installing and Licensing IDL 5.6 for Windows

Licensing IDL with a Personal Use License

After installing IDL, use the licensing wizard to install the license key for your personal use license. Your license key will be sent to you via e-mail or fax. If you have not received your license key, contact your RSI sales representative to request a personal use license.

Save the License File

If your license key arrived via e-mail, you can save the e-mail message out to a file so that the licensing wizard can import it. Complete the following steps:

1. From your e-mail application, save the license key e-mail anywhere on your system as a file.
2. With a text editor, remove any lines that appear before the beginning of the actual license information, and either save the file or copy the edited license information text to the Windows clipboard.

Enter the License Key

To enter your license key:

1. Start the IDL Licensing Wizard. If you have already exited the installation program and licensing wizard, click the Windows Start button, and select Programs → Research Systems IDL 5.6 → License.
2. Display the Permanent Licensing dialog. Click Permanent and then License from the licensing wizard.
3. Enter your license key. Paste the text of the license key into the dialog, or click Browse to select the license file you saved on your system. If you paste in your license key text, remove any header lines that are included in the file but keep the comment lines that begin with the “#” character. If you have received your license key via fax or other hardcopy method, type the information directly into the text window.
4. Save the license file. Click Next to save the license file in the directory where you have installed the software. The licensing wizard recognizes where you have installed the software and generates the appropriate path: RSI-DIR\license\license.dat.
Note
If you receive a message that there is an existing license file, save the existing file under a different name before proceeding. While the new license usually contains information for all currently licensed products, save the old file as a safeguard against destroying license information. Run the license wizard again to save the new license file in the default location.

5. Exit the licensing wizard. Click Finish to save the license file.

Note
If you need to save the license file in a directory other than the default $RSI-DIR\license\license.dat, you must set an environment variable pointing to the license.dat file before starting the software or the license manager. See “Saving the License File in an Alternative Location” on page 60 for instructions.

Troubleshooting a Personal Use License

1. Check the License Format

After installing the permanent license information via the licensing wizard program, one of the following error messages appears when attempting to start IDL:

% LICENSE MANAGER: Future license file format or misspelling in license file.
The file was issued for a later version of FLEXlm than this program understands.
Feature: idl
License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
FLEXlm error: -90,313. System Error: 2 ""

% LICENSE MANAGER: Invalid license file syntax
Feature: idl
License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
FLEXlm error: -2,134. System Error: 2 ""

These errors may indicate that the license information has been corrupted.

Some email programs can corrupt license text, replacing original characters with invalid characters. For example, the string:

VENDOR_STRING="000011Research Systems, Inc." HOSTID=00b012345678 ck=99

could be inadvertently changed to:
Another cause of license corruption is inadvertent line wrapping introduced by the email program. For example, a line in the license might be changed from (2 lines).

Correct format:

\[
\text{INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71 } \\
\text{VENDOR\_STRING=000011Research Systems, Inc.\"} \\
\text{HOSTID=00b012345678 ck=123}
\]

Incorrect format:

\[
\text{INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71 } \\
\text{VENDOR\_STRING=000011Research Systems, Inc.\"} \\
\text{HOSTID=00b012345678 ck=123}
\]

If the license file appears to have been corrupted, try to restore the problem characters or line wrapping to its original state. Or if a separate file attachment of the license information was provided please use the license information in the file attachment to replace the corrupted license information. The licensing wizard may be used to edit the license file information that has already been installed.

2. License file does not support this version

After installing the permanent license information via the licensing wizard program, a form of the following error message appears when attempting to start IDL:

\[
\% \text{ LICENSE MANAGER: License file does not support this version}\niidl Application version > License version: 5.6 > 5.400\n\text{License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic}\n\text{FLEXlm error: -21,126. System Error: 2 ""}\n\]

Confirm that the license being referenced contains the correct version. Check the license(s) listed in the "license path" of the error message to verify the contents of the referenced license. Below is an example of an IDL 5.6 license feature (2 lines):

\[
\text{INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71 } \\
\text{VENDOR\_STRING=000011RSI HOSTID=00b012345678 ck=123}
\]

Notice that the product “idl” is listed after “INCREMENT” and the IDL version “5.600” is located after “idl_lmgrd”. An IDL 5.6 FLEXlm license can also support previous versions of IDL.

If the listed IDL version is less than the version you are trying to license, then an old version of the license is being referenced. Make sure you that the correct version of
the license.dat file is being referenced. See “Saving the License File in an Alternative Location” on page 60 for more information.

If the you do not have a license with the correct version, you must request another license. See “Requesting a License” on page 29 for information on how to request a license.

3. IDL cannot find license

After installing the license information via the licensing wizard, an error message appears that indicates that the license.dat file cannot be found.

% LICENSE MANAGER: Cannot find license file
The license files (or server network addresses) attempted are listed below. Use LM_LICENSE_FILE to use a different license file, or contact your software provider for a license file.
Feature: idl
Filename: C:\RSI\IDL56\license.dat
License path: C:\RSI\IDL56\license.dat
FLEXlm error: -1,359. System Error: 2 "No such file or directory"

Make sure that you have either installed the license.dat in the default location (RSI-DIR/license/license.dat) or that you have defined your LM_LICENSE_FILE environment variable to the path where the license.dat file exists. See “Saving the License File in an Alternative Location” on page 60 for more information.

If this information is correct, try the following (if using Windows NT, 2000 or XP, you should be logged on as a user with administrative privileges before proceeding):

1. Quit any IDL session.
2. Open a Windows Explorer and browse to the bin\bin.x86 subdirectory the IDL installation (for example: C:\RSI\IDL56\bin\bin.x86).
3. Find the file “idl.000.” If you can't find the idl.000 file in the bin.x86 directory select the View menu for Windows NT, or the Tools menu for Windows 2000 or XP, of the Windows Explorer, then select Folder Options. Then, under the View tab:
   • Select the option for Show hidden files and folders.
   • Clear the box for the option: Hide file extensions for known file types.
   • Apply and save the changes.
4.) After locating the “idl.000” file in the bin.x86, rename it to “idl.ini.”
5.) Start a session of IDL.
6.) When prompted to import preferences, select Yes.

If the licensing information is correct, IDL should find the license and start in licensed mode.

4. **Search the RSI Technical Support Library**

Go to [www.RSInc.com/services/search.cfm](http://www.RSInc.com/services/search.cfm) and select the following for more information on troubleshooting personal licensing:

<table>
<thead>
<tr>
<th>Product:</th>
<th>IDL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform:</td>
<td>WINDOWS</td>
</tr>
<tr>
<td>Category:</td>
<td>LICENSING</td>
</tr>
<tr>
<td>Functional Area:</td>
<td>LICENSING - FLEXlm</td>
</tr>
</tbody>
</table>

5. **Contact RSI Technical Support**

If you are still having problems licensing, see “Contacting RSI” on page 10 for information on how to contact Technical Support.
Licensing IDL with a Node-Locked License

After installing IDL, use the licensing wizard to install the license key for your node-locked license. Your license key will be sent to you via e-mail or fax. If you have not received your license key, see “Requesting a License” on page 29.

Save the License File

If your license key arrived via e-mail, you can save the e-mail message out to a file so that the licensing wizard can import it. Complete the following steps:

1. From your e-mail application, save the license key e-mail anywhere on your system as a file.
2. With a text editor, remove any lines that appear before the beginning of the actual license information, and either save the file or copy the edited license information text to the Windows clipboard. For an example of a license key, see “Node-Locked License” on page 16.

Enter the License Key

To enter your license key, complete the following steps:

1. Start the IDL Licensing Wizard. If you have already exited the installation program and licensing wizard, click the Windows Start button, and select Programs → Research Systems IDL 5.6 → License.
2. Display the Permanent Licensing dialog. Click Permanent and then License from the licensing wizard.
3. Enter your license key. Paste the text of the license key into the dialog, or click Browse to select the license file you saved on your system. If you paste in your license file, remove any header lines that are included in the file but keep the comment lines that begin with the “#” character. If you have received your license file via fax or other hardcopy method, type the information directly into the text window.

Note

The license key consists of non-indented lines, indented lines, and blank lines. Besides the comment lines (lines beginning with the number sign (#)), non-indented lines should begin with either a FEATURE or INCREMENT keyword. Because of e-mail/fax limitations, extra-long lines of the license key may have been inadvertently wrapped to a new line. If a non-indented line begins with a character other than a number sign (#) or a FEATURE or
Chapter 2: Installing and Licensing IDL 5.6 for Windows

INCREMENT keyword, then it is likely that an extra-long line has been incorrectly wrapped and that the segment belongs at the end of the previous line. Make sure that you review your license key for these possible errors. If the key does contain an error, the software will not be licensed.

4. **Save the license file.** Click **Next** to save the license file in the directory where you have installed the software. The licensing wizard recognizes where you have installed the software and generates an appropriate path, for example, \RSI-DIR\license\license.dat.

*Note* If you receive a message that there is an existing license file, save the existing file under a different name before proceeding. While the new license usually contains information for all currently licensed products, save the old file as a safeguard against destroying license information. Run the license wizard again to save the new license file in the default location.

5. **Exit the licensing wizard.** Click **Finish** to save the license file.

*Note* If you need to save the license file in a directory other than the default \RSI-DIR\license\license.dat, you must set an environment variable pointing to the license.dat file before starting the software or the license manager. See “Saving the License File in an Alternative Location” on page 60 for instructions.

**Troubleshooting a Node-Locked License**

1. **Check the License Format**

After installing the permanent license information via the licensing wizard program, one of the following error messages appears when you attempt to start IDL:

```
% LICENSE MANAGER: Future license file format or misspelling in license file
The file was issued for a later version of FLEXlm than this program understands.
Feature: idl
License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
FLEXlm error: -90,313. System Error: 2
```

```
% LICENSE MANAGER: Invalid license file syntax
Feature: idl
```
License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
FLEXlm error: -2,134. System Error: 2 ""

These errors may indicate that the license information has been corrupted.

Some email programs can corrupt license text, replacing original characters with invalid characters. For example, the string:

VENDOR_STRING="000011Research Systems, Inc." HOSTID=00b012345678 ck=99

could be inadvertently changed to:

VENDOR_STRING?"000011Research Systems, Inc." HOSTID?00b012345678 ck?99

Another cause of license corruption is inadvertent line wrapping introduced by the email program. For example, a single line in the license might be changed to two lines.

Correct format:

INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71 \ VENDOR_STRING="000011Research Systems, Inc." HOSTID=00b012345678 ck=123

Incorrect format:

INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71 \ VENDOR_STRING="000011Research Systems, Inc." HOSTID=00b012345678 ck=123

If the license file appears to have been corrupted, try to restore the problem characters or line wrapping to its original state. Or if a separate file attachment of the license information was provided, please use the license information in the file attachment to replace the corrupted license information. The licensing wizard may be used to edit the license file information that has already been installed.

2. The hostid of this system does not match the hostid

After installing the permanent license information via the licensing wizard, a form of the following error message appears when starting IDL:

% LICENSE MANAGER: Invalid host
  The hostid of this system does not match the hostid specified in the license file
  Feature: idl
  Hostid: 00b0d0911470
  License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
  FLEXlm error: -9,57. System Error: 2 ""
Licensing IDL with a Node-Locked License

Confirm that the node-locked hostid in the license matches the actual hostid of the machine that is running IDL:

1. Start the licensing wizard by clicking **Start → Programs → Research Systems IDL 5.6 → License**.
2. Click **Permanent** and then **Request**.
3. Compare the Node LMHostid value with the HOSTID value in your IDL license file.

For example the following IDL license feature line:

```
INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71
VENDOR_STRING=000011RSI HOSTID=00b012345678 ck=123
```

is built for the node hostid “00b012345678”.

If the hostid information obtained from the licensing wizard is different from the information listed in the license file, then the license will not work with your machine. The license HOSTID value cannot be altered by a user without invalidating the license. If the host on which you are installing is different from the one on which you previously installed, you must request another license. See “Requesting a License” on page 29 for information on how to request a license.

3. License file does not support this version

After installing the permanent license information via the licensing wizard program, a form of the following error message appears when attempting to start IDL:

```
% LICENSE MANAGER: License file does not support this version
Feature: idl
Application version > License version: 5.6 > 5.400
License path: C:\RSI\license\license.dat;C:\RSI\license\*.lic
FLEXlm error: -21,126. System Error: 2 ""
```

Confirm that the license being referenced contains the correct version. Check the license(s) listed in the "license path" of the error message to verify the contents of the referenced license. Below is an example of an IDL 5.6 license feature (2 lines):

```
INCREMENT idl idl_lmgrd 5.600 1-jan-0000 0 EC3B7DA4CA19E85C0A71
VENDOR_STRING=000011RSI HOSTID=00b012345678 ck=123
```

Notice that the product “idl” is listed after “INCREMENT” and the IDL version “5.600” is located after “idl_lmgrd”. An IDL 5.6 FLEXlm license can also support previous versions of IDL.

If the listed IDL version is less than the version you are trying to license, then an old version of the license is being referenced. Make sure you that the correct version of
the license.dat file is being referenced. See “Saving the License File in an Alternative Location” on page 60 for more information.

If you do not have a license with the correct version, you must request another license. See “Requesting a License” on page 29 for information on how to request a license.

4. Cannot find license

After you install the license information via the licensing wizard, an error message appears that indicates that the license.dat file cannot be found.

% LICENSE MANAGER: Cannot find license file

The license files (or server network addresses) attempted are listed below. Use LM_LICENSE_FILE to use a different license file, or contact your software provider for a license file.

Feature: idl
Filename: C:\RSI\IDL56\license.dat
License path: C:\RSI\IDL56\license.dat
FLEXlm error: -1,359. System Error: 2 "No such file or directory"

Make sure that you have either installed the license.dat in the default location (RSI-Dir/license/license.dat) or that you have defined your LM_LICENSE_FILE environment variable to the path where the license.dat file exists. See “Saving the License File in an Alternative Location” on page 60 for more information.

If this information is correct, try the following (if using Windows NT, 2000 or XP, you should be logged on as a user with administrative privileges before proceeding):

1. Quit any IDL session.

2. Open Windows Explorer and browse to the bin\bin.x86 subdirectory of the IDL installation directory (for example: C:\RSI\IDL56\bin\bin.x86).

3. Find the file “idl.000.” If you can't find the idl.000 file in the bin.x86 directory select the View menu for Windows NT, or the Tools menu for Windows 2000 or XP, of the Windows Explorer, then select Folder Options. Then, under the View tab:
   - Select the option for Show hidden files and folders.
   - Clear the box for the option: Hide file extensions for known file types.
   - Apply and save the changes.

4.) After locating the “idl.000” file in the bin.x86, rename it to “idl.ini.”

5.) Start a session of IDL.
6.) When prompted to import preferences, select Yes. If the licensing information is correct, IDL should find the license and start in licensed mode.

5. Search the RSI Technical Support Library

Go to www.RSIInc.com/services/search.cfm and select the following for more information on troubleshooting node-locked licensing:

- Product: IDL
- Platform: WINDOWS
- Category: LICENSING
- Functional Area: LICENSING - FLEXlm

6. Contact RSI Technical Support

If you are still having problems licensing, see “Contacting RSI” on page 10 for information on how to contact Technical Support.
Licensing IDL with a Floating License

After installing IDL, use the following instructions to:

- Set Up the License Server
- Configure Clients to Access the License Server

Your license key will be sent to you via e-mail or fax. If you have not received your license key, see “Requesting a License” on page 29.

Set Up the License Server

1. Save the License File

If your license key arrived via e-mail, you can save the e-mail message to a file so that the licensing wizard can import it. If your information was faxed to you or you prefer to directly enter the text into the licensing wizard, continue with the next section.

To save the license key to a file, complete the following steps:

1. From your e-mail application, save the license key e-mail anywhere on your system as a file.
2. With a text editor, remove any lines that appear before the beginning of the actual license information, and either save the file or copy the edited license information text to the Windows clipboard. For an example of a license key, see “Floating License” on page 16.
3. Copy the file anywhere on your designated license server machine.

2. Enter the License Key

To enter your license key, complete the following steps:

1. Start the IDL Licensing Wizard. On your designated license server machine, click the Windows Start button, and select Programs → Research Systems IDL 5.6 → License.
2. Display the Permanent Licensing dialog. Select Permanent and then License from the licensing wizard dialogs.
3. Enter your license file. Paste the text of the license file into the dialog, or select Browse to select the license file which you have saved on the designated license server machine. If you paste in your license file, remove any header lines that are included in the file but keep the comment lines that begin with
Licensing IDL with a Floating License

the “#” character. If you have received your license file via fax or other hardcopy method, type the information directly into the text window.

Note
The license key consists of non-indented lines, indented lines, and blank lines. Besides the comment lines (lines beginning with the number sign (#)), non-indented lines should begin with either a SERVER, DAEMON, FEATURE, or INCREMENT keyword. Because of e-mail/fax limitations, extra long lines of the license key may have been inadvertently wrapped to a new line. If a non-indented line begins with a character other than a number sign (#), or a word other than a keyword (SERVER, DAEMON, FEATURE, INCREMENT, etc.), then it is likely that an extra-long line has been incorrectly wrapped and that the segment belongs at the end of the previous line. Make sure that you review your license key for these possible errors. If such an error is not corrected, the software will not be licensed.

4. **Save the license file.** Click **Next** to save the license file in the directory where you have installed the software. The licensing wizard recognizes where you have installed the software and generates an appropriate path, for example, `RSI-DIR\license\license.dat`.

Note
If you need to save the license file in a directory other than the default `RSI-DIR\license\license.dat`, you must set an environment variable pointing to the `license.dat` file before starting the license manager. See “Saving the License File in an Alternative Location” on page 60 for instructions.

5. **Exit the licensing wizard.** Click **Finish** to save the license file.

Note
If you receive a message that there is an existing license file, save the existing file under a different name before proceeding. While the new license usually contains information for all currently licensed products, save the old file as a safeguard against destroying license information.

Note
If you have other software that is using the Globetrotter Software FLEXlm license manager, you may want to combine the RSI license file with the existing ones. See “Multiple Applications Using the Same License Server” on page 53 for options and instructions.
3. Start the License Server

With a floating license, you will need to start the license server before RSI products can access a network license and run in licensed mode. You may also set up your system so that the license manager is automatically started when your system is booted.

The license manager needs to be started only on the designated license server machine, not on client machines accessing the IDL product from the network. However, client machines do need to be set up to access the RSI software and the license file. After installing the license manager, see “Configure Clients to Access the License Server” on page 48 for instructions.

The Network License Server

The license server is a custom install option in the software product installation for Windows. You must install the license server on the Windows NT/2000/XP machine that will be the license server.

Access to the license manager utilities requires installation of the Network License Server option during your software installation. This option installs the following files in the $RSI-DIR/IDL56/bin/bin.x86 directory:

- install_lm_server.exe
- lmgrd.exe
- idl_lmgrd.exe
- lmutil.exe
- lmtools.exe

Configuring the License Server

After entering and saving the license file, you must start the license server on your server machine. Included with your installation is a graphical interface for configuring the license manager, the LMTools utility. With this utility, you can set environment paths and start, stop, and monitor the license manager.

1. **Open LMTOOLS.** Using Windows Explorer, navigate to the $RSI-DIR/IDL56/bin/bin.x86 directory, where $RSI-DIR is the path to your RSI product installation directory. Double-click lmtools.exe. The LMTools dialog is displayed.

2. **Check for existing license managers.** At the Service/License tab, select Configuration using Services, and click the Config Services tab. If more than one service is listed, the potential exists for conflict between the license...
Licensing IDL with a Floating License

3. **Set up the license paths.** At the **Config Services** tab, do the following:
   - Click in the **Service Name** text box to select the default name, and type over the default name to name your service.
   - Tab down to the **Path to the lmgrd.exe file** text box and click **Browse**.
   - Navigate to the \RSI-DIR\IDL56\bin\bin.x86 folder, select the lmgrd.exe file, and click **Open**.
   - Tab down to the **Path to the license file** text box and click **Browse**.
   - Navigate to the folder containing your license.dat file (C:\RSI\license\ is the default), select the license.dat file, and click **Open**.
   - Tab down to the **Path to the debug log file** text box and click **Browse**.
   - Specify a path and a filename for the FlexLM licensing log file and click **Open**. (You can use the **View Log...** button to view the contents of the log or the **Close Log** button to stop logging contents to this file.)
   - Click to select **Use Services**, and click to select **Start Server at Power Up**.
   - Click **Save Service**, and answer **Yes** to save your configuration.

**Start the License Manager**

You can start the license manager from the LMTools utility.

1. Click the **Start/Stop/Reread** tab.
2. Make sure the name of your service is highlighted, and click **Start Server**.

   **Note**
   If you receive a message that the service is already started, click **Stop Server** to stop the service, and then click **Start Server** to start it again with the new licensing configuration.

3. Click the close button \x to exit the LMTools utility.
Configure Clients to Access the License Server

To allow network access to a license manager installed on a server, the client machines must have access to the license file used by the license manager. RSI recommends having a local installation of your RSI product on each client machine and referencing the license.dat file stored on the server machine. Set each client machine's System Environment variables to point to the license.dat file stored on the server to easily keep each installation updated with a current license.

For more information on license manager utilities, see “Working with the License Server” on page 50.

Windows NT/2000

Complete the following steps for each client machine:

1. **Access the System Control Panel.** Click Start → Settings → Control Panel. Double-click the System icon.
2. **Select the Environment tab.** (For Windows 2000, select the Advanced tab and then select Environment.) In the upper System Variables list, scroll down to the bottom and click in the white area. None of the currently listed variables should be highlighted.
3. **Enter a new System variable.**
   A. In the Variable field, enter LM_LICENSE_FILE.
   B. In the Value field, enter your server’s port@host value, for example 1700@hal. This information is in your license file. The port number is the last number on the SERVER line. The host name immediately follows SERVER.

   **Note**
   If LM_LICENSE_FILE has already been defined for another software product, the definition of this license file may be appended using a semicolon (;) as the delimiter. For example:

   C:\license\mylicense.dat;1700@hal
4. **Save the Settings.** Click Set, Apply and OK. Your Environment dialog box should be similar to the following picture when completed.

![Figure 2-1: Setting Client Environment Variables](image)

**Windows XP Systems**

Complete the following steps for each client machine:

1. **Access the System Control Panel.** Click Start → Control Panel, select the Performance and Maintenance category, and select the System icon.

2. Select the Advanced tab, and click the Environment Variables button.

3. **Enter a new System variable.** Click the New button below the System Variables list.
   
   A. In the Variable Name field, enter LM_LICENSE_FILE.
   
   B. In the Variable Value field, enter your server’s `port@host` value, for example `1700@hal`. This information is in your license file. The port number is the last number on the SERVER line. The host name immediately follows SERVER.
Note
If LM_LICENSE_FILE has already been defined for another software product, the definition of this license file may be appended using a semi-colon (;) as the delimiter. For example:

C:\license\mylicense.dat;1700@hal

4. Save the settings. Click OK, OK, and OK.

Windows 98 Systems
Using the previous example, add the setting for the environment variable to the autoexec.bat file as follows:

SET LM_LICENSE_FILE = 1700@hal

The system must be restarted in order for this setting to take effect.

Note
If LM_LICENSE_FILE has already been defined for another software product, the definition of this license file may be appended using a semi-colon (;) as the delimiter. For example:

SET LM_LICENSE_FILE = C:\license\mylicense.dat;1700@hal

For more information on customizing floating licenses, see Appendix A, “Customizing Your Floating Licenses”.

Working with the License Server
A license server support utility, LMTools, is provided to control the operation of the license server. For information on setting up the license manager, see “Configuring the License Server” on page 46.

Starting and Stopping the License Manager
With the LMTools utility, you can easily start, stop and see the status of the license manager. To open the LMTools utility:

1. Navigate to the RSI-DIRIDL56\bin\bin.x86 directory, where RSI-DIR is the path to your IDL installation directory.

2. Double-click lmtools.exe.
Licensing IDL with a Floating License

Starting the license manager — Click the Start/Stop/Reread tab, select the name of the license manager service, and click Start to start the license manager.

Monitoring the license manager — Click the Server Status tab to see the current operational status of the license manager.

Stopping the license manager — Click Stop at the Start/Stop/Reread tab to disable the license manager. Your software will run only in seven-minute demonstration mode without an available license.

Removing the License Manager Service

To remove the license manager service, open the LMTools utility. Select the name of the license manager service at the Config Services tab and click Remove Service.

Note

This command removes the license manager service, and should not be used to simply stop the service. To stop the service, see “Starting and Stopping the License Manager” on page 50.

Reclaiming an Unused License

If a licensed user is running IDL when the machine crashes, that user’s license may fail to return to the server. In this case, the license is not available to other users. The lmremove program allows the system administrator to remove a single user’s license for a specified feature and return the license to the pool of available licenses.

To free the license, complete the following steps:

1. **Start the license manager utility.** Open a DOS based Command Prompt window from the server machine and change the directory to access the license manager utility by typing the following at the prompt:

   cd RSI-Dir\IDL56\bin\bin.x86

   Enter lmutil at the prompt to access the utility program. A list of possible commands is displayed.

2. **Gather the information necessary to remove the license.** Review the license manager status by entering the following at the command prompt:

   lmutil lmstat -a.

   This command displays available licenses and which users have licenses checked out. An example output of lmstat -a follows:
Licensing IDL with a Floating License

The format of this line is:

\[
\text{user host display (version) (host/port/license handle), start_date, available_licenses}
\]

Note the user, host, and display values.

3. **Remove the unused license.** Use the following to remove a license:

   \[
   \text{lmutil lmremove feature user host display}
   \]

   For example:

   \[
   \text{lmutil lmremove idl robin hal7 josh}
   \]

   where `idl` is the feature, `robin` is the user, `hal7` is the host, and `josh` is the display. Other feature values for Research System products appear in the table below.

<table>
<thead>
<tr>
<th>RSI Software Product</th>
<th>Feature Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDL</td>
<td>idl</td>
</tr>
<tr>
<td>IDL Runtime</td>
<td>idl_rt</td>
</tr>
<tr>
<td>IDL with the Wavelet Toolkit</td>
<td>idl_wavelet</td>
</tr>
<tr>
<td>IDL DataMiner</td>
<td>idl_dm</td>
</tr>
<tr>
<td>IDL MPEG</td>
<td>idl_mpeg</td>
</tr>
<tr>
<td>Right to Distribute</td>
<td>devkit</td>
</tr>
<tr>
<td>ENVI</td>
<td>envi</td>
</tr>
<tr>
<td>ION Script</td>
<td>ion_script</td>
</tr>
<tr>
<td>ION Java</td>
<td>ion_java</td>
</tr>
<tr>
<td>RiverTools</td>
<td>idl_rivertools</td>
</tr>
<tr>
<td>Noesys</td>
<td>noesys</td>
</tr>
<tr>
<td>VIP</td>
<td>vip</td>
</tr>
</tbody>
</table>

*Table 2-2: Feature Values for lmremove*

4. **Verify that the license has been removed.** You can check to make sure the license was freed by typing the following at the DOS command prompt:
Licensing IDL with a Floating License

```
lmutil lmstat -a
```

The license you just removed should no longer appear in the list of licenses checked out.

If the license manager gives an error message when starting, see “Troubleshooting the License Server Startup” on page 57.

Multiple Applications Using the Same License Server

IDL’s network license server facility is provided by the FLEXible License Manager (FLEXlm), a product of Globetrotter Software. Since this license manager is not unique to IDL, the possibility exists that you will need to run software from two or more software vendors that all use FLEXlm. In this case, the potential for license server conflict exists. You have the following options if all products using FLEXlm are installed on the same license server.

All Products Using FLEXlm are Installed on the Same Server

If an RSI product and other vendor product(s) using FLEXlm license management software are all installed on the same server machine, there are two options:

- Combine all license files into a single license file.
- Create unique license manager services for each product.

Combining License Files

If separate vendor applications using FLEXlm software are installed on the same server machine, and each vendor’s license file contains a SERVER line with an identical LMhostid, the solution is simple. After shutting down the license servers, use a text editor to create a single license file. In this single license file, combine all license files by taking the SERVER lines from any one license file, and adding all the DAEMON, FEATURE, FEATURESET, and INCREMENT lines from all of the license files.

Multiple copies of this combined license file can be placed in the locations required by the various software vendors. Alternatively, a single copy of the license file can be located in any convenient location, in which case each client machine must set the LM_LICENSE_FILE environment variable to point to it.

When you have finished editing the license file, and saved it in the appropriate locations, restart the license manager with the most recent version of lmgrd that you have installed. From Windows Explorer, right click on each instance of lmgrd.exe and select the Version tab in the Properties menu. If an older version of lmgrd is
used, the license manager from the product with a more recent \texttt{lmgrd} will not operate correctly.

**Configuring Unique FLEXlm License Manager Services on the Same Server**

As an alternative to combining the license information from multiple vendors licenses and running a single instance of the FLEXlm license manager service, a separate instance of the FLEXlm license manager service (with a unique name) can be installed and started for each separate vendor's license file.

Using separate instances of the FLEXlm license manager service with separate vendor licenses requires administering multiple services and license files. However, multiple license manager services and separate vendor license files allow the system administrator to stop and start FLEXlm services freely for particular vendors without regard for other vendors’ FLEXlm services running on that same system.

**Warning**

Be certain that only one instance of the FLEXlm license manager will start on the server machine with respect to any RSI product license file. If an instance of FLEXlm license manager service is already running for an RSI product on this same license server machine, then installing a second instance of the FLEXlm service for an RSI product under a different name can cause a conflict when Windows is loaded. (To resolve such a conflict, quickly stop all but one of the conflicting FLEXlm services immediately after logging on to that Windows license server machine.)

After verifying that there is not already an RSI product-configured license manager service running on your server machine, you can configure an uniquely named instance of the license manager service for RSI products to avoid conflict with other vendors’ license managers. To install a unique instance of the FLEXlm license manager for an RSI product license file, complete the following steps:

1. Confirm that your updated RSI product license is already properly installed on the license server machine.

2. Open the LMTools utility from \texttt{RSI-DIR\IDL56\bin\bin.x86}.

3. Select the **Config Services** tab and enter a new (unique) FLEXlm service name in the **Service Name** field. By default, the FLEXlm license manager service is called “FLEXlm License Manager”. If the name “FLEXlm License Manager” is configured and already being used for another vendor's product license file, we recommend using the name “RSI FLEXlm License Manager” instead.
4. Enter the paths to the RSI product’s lmgrd.exe and license.dat files. If not already created, the Debug Log File, typically saved in the license directory, will be created when the license manager is started. The Browse buttons can help to ensure that the file path entered is valid.

5. Select the Use Services and the Start Server at Power-Up check boxes.

6. Start the newly named license manager. Select the Start/Stop/Reread tab, select the name of the updated service, and start the service by clicking the Start Server button.

7. Click the close button to exit the LMTools utility.

Troubleshooting a Floating License

If your RSI product runs in seven minute demonstration mode after you have attempted to license the product, follow the appropriate suggestions below and try starting IDL again. If you see errors from the license manager itself, turn to “Troubleshooting the License Server Startup” on page 57.

Note

Useful messages may be logged in the license manager output log file that is designated at the time the FLEXlm service is installed.

1. Check that the license server is running.

Open the LMTools utility from the RSI-DIR\IDL56\bin\bin.x86 directory. Click the Perform Status Inquiry button on the Server Status tab. If you receive a message that states the license manager cannot connect to the license server, proceed to step 5.

2. Stop and restart the license manager.

Exit IDL. Stop and then restart the license manager.

3. Is the LM_LICENSE_FILE environment variable set to the license file of another application?

See “Saving the License File in an Alternative Location” on page 60 to check the setting of the LM_LICENSE_FILE environment variable. If LM_LICENSE_FILE points to a license file other than the RSI product’s license file, stored in the RSI-DIR\license directory, you will need to correct this prior to starting IDL.
4. Is the license server reachable from your machine?

If IDL displays the following error message at startup:

```
LICENSE MANAGER: cannot connect to license server.
```

make sure that you can use the network utility “ping” to contact the server machine. Open your system’s MS-DOS command prompt, enter:

```
ping server_name
```

If you can ping the server machine, ensure that the license manager is running on that machine.

5. Has your license file been copied correctly?

If IDL displays the following error message at startup:

```
% LICENSE MANAGER: encryption code in license file is inconsistent.
```

some of the encrypted information in the license file is not correct. This can involve the server hostid, the daemon name, and any character on the FEATURE lines.

Examine your license file and correct the INCREMENT or FEATURE line so that it exactly matches the one sent to you by RSI. Check for proper capitalization and spacing. Shut down the license manager service, make any corrections necessary, and restart the service with the corrected license file.

6. Is the license manager using the correct license file?

If IDL displays the following error message at startup:

```
LICENSE MANAGER: no such feature exists.
LICENSE MANAGER: license file does not support this feature.
```

the license manager may be using the wrong license file. See the section, “Configuring the License Server” on page 46 for details.

7. Does the license file contain the correct hostname?

If IDL displays the following error message at startup:

```
% LICENSE MANAGER: cannot find SERVER hostname in network database.
```

the hostname in the license file does not agree with the actual hostname for the server, or cannot be accessed from the client node. Edit the license file and correct the hostname.
8. Search the RSI Technical Support Library

Go to www.RSInc.com/services/search.cfm and select the following for more information on troubleshooting floating licensing:

- **Product:** IDL
- **Platform:** WINDOWS
- **Category:** LICENSING
- **Functional Area:** LICENSING - FLEXlm

9. Check the Globetrotter Web Site.

The Globetrotter Web site contains on-line documentation and an excellent FLEXlm FAQ. This information can be helpful when trying to combine licenses from different vendors. See the following Web pages:

- **Globetrotter home page:** http://www.globetrotter.com
- **FLEXlm FAQ:** http://www.globetrotter.com/flmfaq.htm

10. Contact RSI Technical Support

If you are still having problems licensing, see “Contacting RSI” on page 10 for information on how to contact Technical Support.

Troubleshooting the License Server Startup

If the license server gives an error message when starting, find the error message below and follow the instructions to eliminate the error.

1. **Invalid Server Hostname**

   
   \[\begin{aligned}
   \text{date time (lmgrd) "Hostname1": Not a valid server hostname, exiting.} \\
   \text{date time (lmgrd) Valid server hosts are: "Hostname2"}
   \end{aligned}\]

   In spite of the error message, \textit{Hostname1} is the hostname of the server that probably should be in the license file, while \textit{Hostname2} is the incorrect hostname currently in the license file. Edit your license file to contain the correct hostname.

2. **Inconsistent Encryption Code**

   \[\begin{aligned}
   \text{date time (idl_lmgrd) Inconsistent encryption code for idl}
   \end{aligned}\]

   There is a problem with the information on the FEATURE or INCREMENT line of the license file. Verify that the license key was entered correctly. Check capitalization and spacing, making sure it is exactly the same as in the license file sent to you.
Finally, check to make sure that long lines in the license file have not been inadvertently wrapped to a new line.

3. No Features to Serve

\textit{date time} (idl_lmgrd) No features to serve!

There are no valid FEATURE or INCREMENT lines. This is most commonly due to the “inconsistent encryption code” error described above.

4. Retrying Socket Bind

\textit{date time} (lmgrd) Retrying socket bind (address in use: port 1700)

An attempt has been made to start the license manager when it was already running. This often happens when the license file contains a mistake, the mistake is corrected, and the license manager is started again before the first attempt has been shut down or killed. There may also be some other software product using the default port number, 1700. Stop the service using the LMTools utility and restart the service.

5. No Such File or Directory

\texttt{license daemon: execl failed: .../idl -T host 2.40 3 -c}
\texttt{license daemon: system error code: No such file or directory}

The path on the DAEMON line of the license file is incorrect. It should point to the IDL directory. Edit the license file and correct the DAEMON line.

6. Cannot Find License File

\texttt{license manager: can't initialize: cannot find license file}
\texttt{(No such file or directory)}
\texttt{date time (lmgrd) Using license file "filename"}

The license manager cannot find the \texttt{license.dat} file. Either the \texttt{license.dat} file is not in the default location or the file specified in the environment variable \texttt{LM_LICENSE_FILE} is incorrect. Also, make sure that the filename \texttt{license.dat} is spelled correctly and that you have read permission for the \texttt{license.dat} file.

7. Cannot Read License File

\texttt{license manager: can't initialize: cannot read license file}
\texttt{(Permission denied)}

The permissions are set incorrectly on the \texttt{license.dat} file. Set the file to allow read permission for all users.
8. Wrong Hostid for Server

Wrong hostid on Server line for license file:
C:\RSI\LICENSE\LICENSE.DAT.
SERVER line says 000c0123454, hostid is 000c0abcde
Invalid hostid on SERVER line.

The hostid in the license file does not match the hostid of the machine. Verify that you are using the correct machine. You may need to request a corrected license file. Make sure that the license file has been correctly copied from the original information sent to you by RSI.

For additional assistance, see “Contacting RSI” on page 10.
Saving the License File in an Alternative Location

RSI strongly recommends saving your license file with the default path and filename: RSI-DIR\license\license.dat, where RSI-DIR is the directory in which your RSI product is installed. If you put your license file in this directory, you do not have to redefine any environment variables.

If you choose a location other than RSI-DIR\license\license.dat for the license file, it must be accessible to RSI software products that you have installed on your machine.

Therefore, you must define the environment variable LM_LICENSE_FILE to point to the actual path of the license file prior to using your software. For example, if you save your license file as C:\RSI\mylicensefiles\license.dat, RSI products will not run properly until you define the LM_LICENSE_FILE variable.

For Windows NT/2000 Systems

1. Click Start → Settings → Control Panel and double-click the System icon.
2. Click the Environment tab. (For Windows 2000, click the Advanced tab, and then click Environment). Scroll down the System Variables scroll box and click in the white area. No variables should be highlighted.
3. Type, in uppercase letters, LM_LICENSE_FILE in the Variable field.
4. Type the path to the license file in the Value field, in this example, C:\RSI\mylicensefiles\license.dat. Replace this value with the actual path to your license file.

   Note
   If the directory name in the path to your license file contains any spaces, put double quotation marks around the entire path. For example, if you save your license file in the Program Files directory, the path would be:

   "C:\Program Files\license.dat"

5. Click Set, Apply, and OK.
For Windows XP Systems

1. **Access the System Control Panel.** Click **Start → Control Panel**, select the **Performance and Maintenance** category, and select the **System** icon.

2. Select the **Advanced** tab, and click the **Environment Variables** button.

3. **Enter a new System variable.** Click the **New** button below the System Variables list.
   
   A. In the **Variable Name** field, type `LM_LICENSE_FILE`.
   
   B. In the **Variable Value** field, type the path to the license file. For example:

   ```
   C:\RSI\mylicensefiles\license.dat
   ```

   **Note**
   
   If the directory name in the path to your license file contains any spaces, put double quotation marks around the entire path. For example, if you save your license file in the Program Files directory, the path would be:

   ```
   "C:\Program Files\license.dat"
   ```

4. **Click OK, OK, and OK.**

For Windows 98 Systems

Using the previous example, add the setting for the environment variable to the `autoexec.bat` file as follows:

```batch
SET LM_LICENSE_FILE = C:\RSI\mylicensefiles\license.dat
```

The system must be restarted in order for this setting to take effect.
Saving the License File in an Alternative Location
Chapter 3:
Installing IDL 5.6 for UNIX

This chapter covers the following topics:

<table>
<thead>
<tr>
<th>Introduction</th>
<th>Installing IDL for UNIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>64</td>
<td>66</td>
</tr>
</tbody>
</table>

Installing and Licensing IDL 5.6
Introduction

Before You Begin

- **Check Your OS Version** — Make sure that you are running on one of the supported UNIX versions listed in “Hardware Requirements for IDL 5.6” on page 11, or a UNIX version that is binary-compatible with one of these versions.

- **You Must be Running X Windows** — The IDL installation program has a Motif graphical user interface and requires you to be running X Windows. If you cannot install from a machine running X Windows, see the instructions in the /install/no_gui directory on your IDL CD-ROM.

Recommended Steps for Installing and Licensing IDL for UNIX

The steps required to install and license IDL depend upon the type of license you will be using. RSI recommends you use the following steps when installing and licensing IDL.

**Evaluation Licenses**

1. **Install IDL** — See “Installing IDL for UNIX” on page 66.

2. **Request a License** — You may have already received an evaluation license key by e-mail or fax. If you haven’t received it, contact your RSI sales representative to request an evaluation license.

3. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.

4. **Enter Your License Key** — See “Licensing IDL with an Evaluation License” on page 84.

5. **Set up and run IDL and ION** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.

**Personal Use Licenses**

1. **Install IDL** — See “Installing IDL for UNIX” on page 66.

2. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.
Chapter 3: Installing IDL 5.6 for UNIX

3. **Request a License** — You may have already received your personal use license key by e-mail or fax. If you haven’t received it, contact your RSI sales representative to request a personal use license.

4. **Enter Your License Key** — See “Licensing IDL with a Personal Use License” on page 86.

5. **Set up and run IDL and ION** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.

**Node-Locked or Floating Licenses**

1. **Install IDL** — See “Installing IDL for UNIX” on page 66.

   **Note**
   
   If you will be installing the License Server on a different machine, see also “Install the License Server” on page 87.

2. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.

3. **Request a License** — You may have already received your RSI product license information by e-mail or fax. It provides your product installation number and additional information about licensing your product. If you haven’t received it, see “Requesting a License” on page 81 to create a license request.

4. **Enter Your License Key** — See “Licensing IDL with a Node-locked or Floating License” on page 87.

5. **Start the License Manager** — See “Start the License Server” on page 90.

6. **Set up and run IDL and ION for each Client Machine** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.
Installing IDL for UNIX

This section describes how to install and license IDL 5.6 for UNIX.

System Requirements

The following are the system requirements for installing IDL 5.6 for UNIX.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>250 MB (minimal recommended disk space for a default installation).</td>
</tr>
<tr>
<td>Operating System</td>
<td>See “Hardware Requirements for IDL 5.6” on page 11 for a complete listing of supported UNIX platforms.</td>
</tr>
<tr>
<td>Network Interface Card</td>
<td>Product licensing procedures require a system equipped with TCP/IP addressable network communication card (for example an ethernet card) and TCP/IP service.</td>
</tr>
</tbody>
</table>

Table 3-1: IDL 5.6 UNIX System Requirements

Mount the IDL CD-ROM on Your System

Some platforms automatically mount the CD-ROM when you insert it into your CD-ROM drive. In most cases, the CD-ROM will be mounted as:

/cdrom/idl_56

The following instructions work in most cases for the platform listed. Consult your operating system documentation for instructions on mounting a CD-ROM on your system.

Note

Replace CDROM-Dev with the actual name of the CD-ROM drive on your system. Type mounting commands as a single line. On most systems, you must have root permissions to mount the CD-ROM.
Chapter 3: Installing IDL 5.6 for UNIX

Chapter 3: Installing IDL 5.6 for UNIX

Installing and Licensing IDL 5.6

Installing IDL for UNIX

Remember how your CD-ROM has been mounted, and use this path in place of CDROM-PATH in the installation instructions.

Table 3-2: CD-ROM Mounting Commands

<table>
<thead>
<tr>
<th>Platform</th>
<th>CD Mounting Command</th>
<th>Typical CDROM-Device Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compaq Tru64 UNIX</td>
<td>/usr/sbin/mount -t cdfs -r -o rrip CDROM-Dev /cdrom</td>
<td>/dev/rz4c</td>
</tr>
<tr>
<td>HP-UX</td>
<td>mount -r -F cdfs CDROM-Dev /cdrom</td>
<td>/dev/dsk/clt2d0</td>
</tr>
<tr>
<td>IBM AIX</td>
<td>mount -r -v cdrfs CDROM-Dev /cdrom</td>
<td>/dev/cd0</td>
</tr>
<tr>
<td>Linux</td>
<td>mount -o ro -t iso9660 CDROM-Dev /mnt/cdrom</td>
<td>/dev/cdrom</td>
</tr>
<tr>
<td>SGI IRIX</td>
<td>(automatically mounted as /CDROM)</td>
<td></td>
</tr>
<tr>
<td>SUN Solaris</td>
<td>(automatically mounted by volume manager as /cdrom/idl_56)</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-2: CD-ROM Mounting Commands

Remember how your CD-ROM has been mounted, and use this path in place of CDROM-PATH in the installation instructions.

Run the IDL Installation Procedure

To install IDL 5.6, complete the following steps:

Note

If you are installing IDL in a public directory, make sure you have root or similar permissions before running the installation script.

1. Execute the installation script. Enter the following command at your UNIX prompt:

   ```
   /bin/sh /CDROM-PATH/xinstall.sh
   ```

   where CDROM-PATH is the path to your CD-ROM drive.

   The Product Installation dialog appears.

2. Read and accept the license agreement. To continue the installation, you must accept the terms of the RSI license agreement. Click Yes to continue.
3. **Choose the installation directory.** The directory listed next to the **Set Directory** button is the directory under which the `idl_5.6` directory will be created. The default installation directory is `/usr/local/rsi`. To change the default, click **Set Directory**. If you do not have write permissions for the selected directory, it will appear as gray text. The selected directory will be created for you if it does not already exist.

4. **Select the options to install.** Move the mouse pointer over each option to display information about that option. Select the check box next to each option you want to install.

5. **Select the platforms to install.** This defaults to the platform on which you are running the installation script. Select or deselect platforms by clicking on the check box next to the option. Select the appropriate platforms for any machines that will run IDL on your network. When installing on a 64-bit machine, both the 32- and 64-bit check boxes will be checked by default.

   **Note**

   **AIX users:** If you are running 64-bit AIX, you will need to manually select the 64-bit check box.

6. **Verify your Selections.** When you have selected the installation directory, options, and platforms for your IDL installation and have made sure you have enough disk space, click **OK**.

7. **Begin the Installation.** The **IDL Installation Summary** dialog displays the options you have selected. If the options shown in the dialog are correct, click **Install** to begin the installation process. If the options are not correct, click **Cancel** to return to the **IDL Installation** dialog.

8. **Set up symbolic links.** Once the installation script has finished copying files to the installation directory, the **Product Environment** dialog appears prompting you whether or not to create symbolic links.

   Symbolic links are shortcuts to the IDL executables that you can create in your home directory or in any directory you specify that users can execute to start IDL. If you want to create symbolic links, click **Create Links**. The **Product Links** dialog appears.

   If you choose not to create symbolic links at this time, you can create them after installing IDL by doing one of the following:

   - **Use the** `RSI-DIR/idl_5.6/bin/install` **executable to create the symbolic links for you.** `RSI-DIR` denotes the RSI product installation...
You must execute this script from the RSI-DIR. Enter the following to create the symbolic links:

cd RSI-DIR
idl_5.6/bin/install

- Make note of the commands you will need to execute to manually create symbolic links. These commands are displayed at the end of the installation process.

9. **Choose the directory in which to create the symbolic links.** This can be your home directory or any other directory from which you want to start IDL. The default directory is /usr/local/bin. This is a directory which is commonly in a user’s paths already. To change the default, click the Set Directory button. If you do not have write permissions for the selected directory, it will appear as gray text. The selected directory will be created for you if it does not already exist.

10. **Specify cgi-bin directory and web path.** If you are installing ION Script, a Script Web Server Configuration dialog will prompt you for the location of your Web server’s CGI executables directory. Enter these locations and click OK.

    **Note**
    Click Cancel if you wish to skip this step. You can complete the ION Script configuration at a later time. See “Manually Configuring Your Unix Web Server” in Chapter 1 of the ION Script User’s Guide manual for more information.

11. **Specify Java Web Server directory and path.** If you are installing ION Java, a Java Web Server Configuration dialog will prompt you for the location of the Web server’s HTML files and the hostname. Enter this information and click OK.

    **Note**
    Click Cancel if you wish to skip this step. You can complete the ION Java configuration at a later time. See “Manually Configuring Your Web Server” in Chapter 1 of the ION Java User’s Guide manual.

12. **Select to License IDL.** To license IDL now, click Yes. For licensing instructions, see “Licensing IDL with a Node-locked or Floating License” on page 87. You can license IDL at a later time by typing rsilicense at the UNIX prompt. To license IDL at a later time, or to run IDL only in seven minute demonstration mode, click No.
13. **Your installation is now complete.** The Installation Complete dialog reports any errors that may have been encountered during installation.

**Note**

IDL online help and manuals require Acrobat Reader with Search 3.0 or greater. A copy of Adobe Acrobat Reader with Search 5.0 (version 4.0 for IRIX and TRU64) has been included on your product CD-ROM. For more information, see “About Adobe® Acrobat® Reader” on page 10.

---

**Unmount the IDL CD-ROM from Your System**

You can now unmount the CD-ROM using one of the following commands where `CDROM-Device` is the name of your CD-ROM drive.

```
umount /CDROM-Device
```

or

```
eject /CDROM-Device
```
Chapter 4:
Installing IDL 5.6 for Macintosh

This chapter covers the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>72</td>
</tr>
<tr>
<td>Installing IDL for Macintosh</td>
<td>74</td>
</tr>
</tbody>
</table>
Introduction

Recommended Steps for Installing and Licensing IDL for Mac OS X

The steps required to install and license IDL depend upon the type of license you will be using. RSI recommends you use the following steps when installing and licensing IDL.

Evaluation Licenses

1. **Install IDL, XDarwin, and OroborOSX** — See “Installing IDL for Macintosh” on page 74.
2. **Start OroborOSX** — See “Start the OroborOSX window manager” on page 76.
3. **Request a License** — You may have already received an evaluation license key by e-mail or fax. If you haven’t received it, contact your RSI sales representative to request an evaluation license.
4. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.
5. **Enter Your License Key** — See “Licensing IDL with an Evaluation License” on page 84.
6. **Set up and run IDL and ION** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.

Personal Use Licenses

1. **Install IDL, XDarwin, and OroborOSX** — See “Installing IDL for Macintosh” on page 74.
2. **Start OroborOSX** — See “Start the OroborOSX window manager” on page 76.
3. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.
4. **Request a License** — You may have already received your personal use license key by e-mail or fax. If you haven’t received it, see “Requesting a License” on page 81 to create a license request.
5. **Enter Your License Key** — See “Licensing IDL with a Personal Use License” on page 86.

6. **Set up and run IDL and ION** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.

### Node-Locked or Floating Licenses

1. **Install IDL, XDarwin, and OroborOSX** — See “Installing IDL for Macintosh” on page 74.

   **Note**
   
   If you will be installing the License Server on a different machine, see also “Install the License Server” on page 87.

2. **Start OroborOSX** — See “Start the OroborOSX window manager” on page 76.

3. **Set up the IDL environment for your machine** — See “Setting Up Your Environment” on page 80.

4. **Request a License** — You may have already received your RSI product license information by e-mail or fax. It provides your product installation number and additional information about licensing your product. If you haven’t received it, see “Requesting a License” on page 81 to create a license request.

5. **Enter Your License Key** — See “Licensing IDL with a Node-locked or Floating License” on page 87.

6. **Start the License Manager** — See “Start the License Server” on page 90.

7. **Set up and run IDL and ION for each Client Machine** — See “Setting Up and Running IDL on UNIX/Macintosh” on page 113.
Installing IDL for Macintosh

System Requirements

The following are the system requirements for IDL 5.6 for Macintosh:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>250 MB (minimal recommended disk space for a default installation).</td>
</tr>
<tr>
<td>Operating System</td>
<td>MacOS X version 10.1 or 10.2.x, running on a Power Mac G4.</td>
</tr>
<tr>
<td>Software</td>
<td>XFree86 version 4.2 (XDarwin 1.0.6). Recommended: OroborOSX window manager</td>
</tr>
</tbody>
</table>

Table 4-1: IDL 5.6 Macintosh System Requirements

Run the IDL Installation Procedure

Installation of IDL 5.6 for Mac OS X is a four-step process:

1. Install the IDL 5.6 program.
2. Install the XFree86 distribution of the XDarwin X server.
3. Install the OroborOSX window manager.
4. Start the OroborOSX window manager.

XDarwin must be installed before OroborOSX. XDarwin provides a fundamental method for allowing applications to draw to the screen, and the OroborOSX window manager enables users to manipulate windows in a way similar to the native Mac OS X Aqua interface.

1. Install IDL 5.6

   1. **Insert the IDL CD-ROM in your CD-ROM drive.** The IDL 5.6 volume window appears. If the window doesn’t appear, double-click the IDL 5.6 CD-ROM icon.
   2. **Start the IDL installation.** Double-click the IDL.5.6_Installer icon. You will be prompted for an administrator login name and password to continue.
   3. Click the lock icon to display the Authenticate screen.
4. Enter the administrator **Name** and **Password**, and click **OK** to continue.

5. The Installer screen is displayed. Click **Continue** to begin the installation process.

6. **View the IDL Release Notes.** The release notes contain important information about this release of IDL. Click **Continue** to proceed.

7. **Accept the license agreement.** In order to continue the installation, you must accept the terms of the RSI license agreement. Click **Continue**, and then click **Accept**.

8. **Select the installation volume and folder.** Select a destination volume by clicking the volume icon. By default, IDL 5.6 will be installed in the `/usr/local/rsi` folder. To specify a different installation folder, click **Choose**, navigate to the desired installation folder, and click **Open**. When you have selected the destination volume and folder, click **Continue** to begin the installation process.

   **Note**
   If you click **Choose** to specify a new installation folder, the Installer does not identify which new folder has been specified. The last folder opened when you click the **Continue** button becomes the new installation folder.

9. At the Easy Install screen, do either of the following:
   - Click **Install** for the default installation. The default, pre-selected options will install the files typically needed to run IDL.
   - Click **Customize** to select which options to install. Check any of the boxes to the left of the features listed to include them in your installation. Click the name of a feature to display information about that feature. Click **Install** if this is a new installation or **Upgrade** if this is an upgrade installation. Or click **Easy Install** to return to the default installation screen.

10. **Finish up the installation.** When the message appears stating that your installation was successful, click **Close**.

### 2. Install the XDarwin X server

1. Double-click the **XInstall** icon in the IDL 5.6 volume window. You will be prompted for an administrator login name and password.

2. Select a language to start the XFree86 XDarwin installer, and click **Continue**.

3. Choose **Full Install**, and follow the instructions to install XDarwin.
4. Click **Finish** when the installation is complete.

5. If you are running MacOS X version 10.2, click the **Jaguar XTerm Update** icon and follow the instructions to install the 10.2 patch for XFree86 XDarwin.

### 3. Install the OroborOSX window manager

1. Double-click the **OroborOSX-vxxx.tar.gz** icon.

2. Ignore the Disk Locked message. Wait for the location browser.

3. Navigate to the desired installation destination and click **OK**.

### 4. Start the OroborOSX window manager

1. Navigate to the OroborOSX installation folder.

2. Double-click the **OroborOSX** icon. OroborOSX launches XDarwin and displays a UNIX X-Windows command line in an OS X window.

3. Your installation is now complete, and you are ready to license IDL 5.6 (see “Licensing IDL 5.6 for UNIX and Macintosh” on page 79).

---

**Note**

IDL online help and manuals require Acrobat Reader with Search 3.0 or greater. A copy of Adobe Acrobat Reader with Search 5.0 has been included on your product CD-ROM. For more information, see “About Adobe® Acrobat® Reader” on page 10.
Removing IDL 5.6 for Macintosh

Removing an IDL 5.6 for Macintosh installation is a two-step process:

1. Use the Finder to locate the Library/Receipts folder, and delete the following files:
   - idl5.6_demo.pkg
   - idl5.6_docs.pkg
   - idl5.6_links.pkg
   - idl5.6_progfiles.pkg

2. Delete the installation folder (default = /usr/local/rsi/idl_5.6), including all of its contents. This will remove IDL 5.6 and any other RSI products installed in the installation folder.

**Note**

To remove IDL, you will need to be logged in as an administrator, and you will need to be familiar with the UNIX file system.
Chapter 5:
Licensing IDL 5.6 for UNIX and Macintosh

This chapter covers the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up Your Environment</td>
<td>80</td>
</tr>
<tr>
<td>Requesting a License</td>
<td>81</td>
</tr>
<tr>
<td>Licensing IDL with an Evaluation License</td>
<td>84</td>
</tr>
<tr>
<td>Licensing IDL with a Node-locked or Floating License</td>
<td>87</td>
</tr>
<tr>
<td>Running IDL</td>
<td>93</td>
</tr>
</tbody>
</table>
Setting Up Your Environment

Before running the licensing wizard, you must set up your environment. You can use predefined setup files included with IDL.

**Note**

Macintosh users must issue these commands from an OroborOSX window. See “Start the OroborOSX window manager” on page 76 for information on opening an OroborOSX window.

If you are using the license server installed on the same platform with IDL, use one of the following:

- For C shell, or T shell (Mac OS X default):
  
  ```
  source RSI-DIR/idl_5.6/bin/idl_setup
  ```

- For Korn shell:
  
  ```
  . RSI-DIR/idl_5.6/bin/idl_setup.ksh
  ```

  where *RSI-DIR* is the main installation directory for IDL.

If you are using a license server that you have installed on a different machine (as described in “Install the License Server” on page 87), use one of the following:

- For C shell, or T shell (Mac OS X default):
  
  ```
  source RSI-DIR/idl_5.6/bin/license_setup
  ```

- For Korn shell:
  
  ```
  . RSI-DIR/idl_5.6/bin/license_setup.ksh
  ```

  where *RSI-DIR* is the main installation directory for the IDL license server.

**Tip**

To avoid typing the setup command at the beginning of every IDL session, include it in your `.cshrc` (`.tcshrc` for Mac OS X) or `.profile` file. See “Define IDL Environment Variables and Aliases” on page 114 for instructions.
Chapter 5: Licensing IDL 5.6 for UNIX and Macintosh

Requesting a License

If you are licensing with a personal use license, a node-locked license, or a floating license, you need a license key from RSI or your distributor. For node-locked and floating licenses, the license key is created using information from the machine on which you will be running the license server. A built-in licensing program has been created to simplify the request and installation of your license file.

**Note**
You do not need to use the licensing wizard to request a license if you are using a personal use or evaluation license. The required information will be automatically sent to you.

**Note**
The electronic registration program can’t retrieve the correct information unless you have a TCP/IP addressable network communication card (for example, an ethernet card) and a TCP/IP service set up on your system.

Note also that you must run the licensing wizard from the license server machine or the node-locked machine, on which you have installed your RSI software. This ensures proper generation of the server LMHostid and Nodename for your license file.

**Note**
You need write permissions for the `RSI-DIR/license` directory in order to save the license request file, `rsi_request.txt`, created by the license wizard.
Preparing a License Request

To prepare a license request, complete the following:

1. **Set up your environment.** See “Setting Up Your Environment” on page 80 for instructions.

2. **Start the IDL Licensing Wizard.** At the UNIX command prompt, type:

   `rsilicense`

   (Macintosh users: The UNIX command prompt is displayed when you launch OroborOSX. You may need to be logged in as root to license IDL. See your system administrator for details.)

   **Note**
   
   You must be logged in as an administrator, or have write permissions on the licensing directory, to license IDL.

3. **Begin the license request process.** Select Permanent from the Permanent Licensing dialog.

4. **Prepare a Request file.** Click Request to prepare a license request file to submit to RSI. The licensing wizard guides you through the creation of a license request file that will contain all the information necessary for RSI to create a valid license file for your software installation.

5. **Enter your information.** Fill in the following text fields in the Permanent Licensing dialog:

   - **Contact Person** — Enter the name of the person to whom the license file should be sent.
   - **E-mail Address** — Enter the e-mail address of the contact person.
   - **Installation Number** — Enter the installation number found on your product installation form. You should have already received this form from RSI by electronic mail or fax. If you have not received it, contact RSI technical support. See “Contacting RSI” on page 10 for more information.
   - **Site Notice** — Enter the name that you want to appear when you launch the software. The name you select will replace `<your site notice>` in the following statement: “licensed for use by `<your site notice>`.” This is typically your company’s name, department, or project.
6. **Select the license type.** Select either **Node Locked** or **Floating**. The license wizard automatically generates the correct Hostname and LMHostid. Do not modify these values.

7. Click **Next** to continue.

8. **Review your license request.** If the information is correct, click **Next** to save the license request file and proceed. If the information is incorrect, edit it in the text window or click **Back** to make any corrections.

9. **Send the license request file.** Click **Next** to send the license request file to RSI. If you did not purchase your software directly from RSI, alter the e-mail address and send the file to your local distributor.

**Note**

If you can’t send e-mail from your machine or if you receive a message stating that an attempt to send the e-mail was unsuccessful, see “Manually Sending a License Request” on page 83. A license file will be sent to you at the e-mail address or fax number you supply.

10. **Exit the License Wizard.** Click **Finish** to exit the license request program.

If you do not receive a license file or any confirmation that the request was received, see “Manually Sending a License Request” on page 83 to re-send the request.

**Manually Sending a License Request**

To manually send a license request, select the appropriate step below and e-mail your request to register@RSInc.com or fax the text of the request file to RSI at 303-786-9909.

- **From the license wizard** — Select **Back** to display the request file. Copy all of the request information into an e-mail message or fax this text to RSI.

- **Outside of the license wizard** — Copy the request file, located in RSI-DIR/license/rsi_request.txt, and send it by fax or e-mail.

**Note**

If you did not purchase your software directly from RSI, send the file to your local office or distributor.
Licensing IDL with an Evaluation License

After installing IDL, use the licensing wizard to install your evaluation license. If you do not have a license key, contact your RSI sales representative to request an evaluation license.

If you have exited the installation program, type rsilicense at the UNIX command prompt. If you have problems with this command, you may need to set environment aliases. See “Set Up the IDL Environment” on page 92.

1. **Set up your environment.** See “Setting Up Your Environment” on page 80 for instructions.

2. **Start the IDL Licensing Wizard.** At the UNIX command prompt, type:
   
   `rsilicense`

   *(Macintosh users: The UNIX command prompt is displayed when you launch OroborOSX. You may need to be logged in as root to license IDL. See your system administrator for details.)*

   **Note**
   
   You must be logged in as an administrator, or have write permissions on the licensing directory, to license IDL.

3. **Access the Evaluation License dialog.** Select the **Evaluation** button on the Product Licensing dialog.

4. **Enter your license information.**
   
   - Select the Product — Select the product you wish to license from the drop-down list. Only installed products are displayed.
   - Enter the Expiration date — For example, 12-oct-2000.
   - Enter the Key code — Enter the key exactly as it appears on your Registration form and click **Next**.

5. **Exit the licensing wizard.** Click **Finish**. IDL is now licensed.

If you have saved your license file in a directory other than `/usr/local/rsi/license`, see “Set Up the IDL Environment” on page 92 for instructions on setting the LM_LICENSE_FILE path environment variable. When your trial period expires, an error message appears stating this fact when you start IDL. Until re-licensed, IDL will operate only in seven-minute demonstration mode.
Troubleshooting Evaluation Licensing

If you receive an error message, locate it below for suggestions on resolving the problem.

1. **The license information does not pass the checksum test.** Carefully check to make sure you have entered your license information exactly as it appears in your RSI product license information. Exactly duplicate capitalization, spacing and the date format as shown on your form.

2. **The license information contains leading or trailing spaces.** If there are any spaces before or after the licensing information, the licensing information may be considered invalid.

3. **The file already exists.** If you have an existing evaluation license for this product, you will be asked if you want to replace it. Select **Yes** to overwrite the old license with the new, extended evaluation license.

4. **The file cannot be written.** You may not have write permissions for the directory or the file to which you are attempting to write. Check the permissions to make sure neither the directory nor any files you are attempting to overwrite are designated as “read-only.” Or you may be required to be logged in as root or an administrator in order to modify the file.
Licensing IDL with a Personal Use License

After you have completed and sent your license request file, as described in “Requesting a License” on page 81, your personal use license file will be sent to you via electronic mail or fax. If your file is sent via e-mail, you can save the e-mail message as a file named license.dat, removing any header lines before the beginning of the actual license information. If you receive your license file via fax, you will have to enter the information into the text window of the license wizard as described below.

1. **Set up your environment.** See “Setting Up Your Environment” on page 80 for instructions.

2. **Start the IDL Licensing Wizard.** At the UNIX command prompt, type:
   
   ```
   rslicense
   ```

   (Macintosh users: The UNIX command prompt is displayed when you launch OroborOSX. You may need to be logged in as root to license IDL. See your system administrator for details.)

   **Note**
   
   You must be logged in as an administrator, or have write permissions on the licensing directory, to license IDL.

3. **Choose the license type.** Select Permanent at the Product Licensing screen.

4. **Request or install a license.** If you have not yet received your license, click Request and proceed to “Preparing a License Request” on page 82. If you have your license information, click License.

5. **Browse for the license.dat file, or enter the license text.** If the license.dat file has been copied to the /usr/local/rsi/license directory, the license text appears in the Enter License Text box. If no text appears in the box, click Browse to locate the file containing the license text, or type the text directly into the box. Click Next to enter the license text.

6. **Save the license.** Click Finish to save the license text and exit the Licensing Wizard.
Licensing IDL with a Node-locked or Floating License

To license your RSI product using a software-based node-locked license or a floating license, you need to enter your license key. After you have completed and sent your license request file, as described in “Requesting a License” on page 81, your license file will be sent to you via electronic mail or fax. If your file is sent via e-mail, you can save the e-mail message as a file named license.dat, removing any header lines before the beginning of the actual license information. If you receive your license file via fax, you will have to enter the information into the text window of the license wizard as described below.

1. Install the License Server

If you are intending the license server to run on a different machine than IDL, you need to install it on that platform. The license server binaries are included on your CD-ROM in the /flexlm directory.

Note

If you are intending to run the license server on the same machine as IDL, the required binaries have already been installed with IDL. You do not need to install the license server binaries using the following instructions.

To install the license server binaries:

1. Do either of the following:
   
   • (UNIX) Mount the IDL CD-ROM on the license server system. Use the mounting instructions located in “Mount the IDL CD-ROM on Your System” on page 66

   or

   • (Macintosh) Insert the IDL CD-ROM.

2. Create the RSI directory. On the server machine, the default location for all of the files is /usr/local/rsi. You need to create this directory using the following command:

   mkdir /usr/local/rsi

   This path will be referenced as RSI-Dir in the remaining instructions in this guide.
3. **Change directory to RSI-DIR.** Change to the directory you created in the previous step:
   
   ```bash
   cd /usr/local/rsi
   ```

4. **Unpack the license server binaries.** There are a set of platform-independent binaries (the `flexlm.tar` file) and a set of platform dependent binaries (the `f_platform.tar` file). To unpack the binaries, use the following commands:
   
   ```bash
   tar -xvf /CDROM-PATH/flexlm/flexlm.tar
   ```

   and

   ```bash
   tar -xvf /CDROM-PATH/flexlm/f_platform.tar
   ```

   where `CDROM-PATH` is the path to your CD-ROM drive and `platform` represents the OS of the platform on which you are installing the binaries.

5. **Do either of the following:**
   - (UNIX) **Unmount the IDL CD-ROM.** Use the unmounting instructions located in “Unmount the IDL CD-ROM from Your System” on page 70
   - (Macintosh) **Eject the IDL CD-ROM.**

2. **Save the License File**

   If your license key arrived via e-mail, you can save the e-mail message to a file so that the licensing wizard can import it. Complete the following steps:

   1. From your e-mail application, save the license file e-mail anywhere on your system as a file named `license.dat`.

   2. With any text editor, remove any header lines that appear before the beginning of the actual license information keeping the comment lines that begin with the “#” character. For an example of a license key, see “Node-Locked License” on page 16.

   3. Copy the `license.dat` file to anywhere on the system you are running IDL if this is a node-locked license or anywhere on the license server if this is a floating license.

3. **Enter the License Key**

   1. **Set up your environment.** See “Setting Up Your Environment” on page 80 for instructions.
2. **Start the IDL Licensing Wizard.** At the UNIX command prompt, type:

```
rsilicense
```

*(Macintosh users:)* The UNIX command prompt is displayed when you launch OroborOSX. You may need to be logged in as root to license IDL. See your system administrator for details.

**Note**
You must be logged in as an administrator, or have write permissions on the licensing directory, to license IDL.

3. **Display the Enter License Text dialog.** Select Permanent and then License from the licensing wizard dialogs.

4. **Enter your license file.** Paste the text of the license file into the dialog’s text window, or select Browse to select the license file which you have named license.dat. If you paste in your license file, remove any header lines that are included in the file but keep the comment lines that begin with the “#” character. If you have received your license file via fax or other hardcopy method, enter the information directly into the text window.

**Note**
The license key consists of non-indented lines, indented lines, and blank lines. Besides the comment lines (lines beginning with the number sign (#)), non-indented lines should begin with either a SERVER, DAEMON, FEATURE, or INCREMENT keyword. Because of e-mail/fax limitations, extra long lines of the license key may have been inadvertently wrapped to a new line. If a non-indented line begins with a character other than a number sign (#) or a SERVER, DAEMON, FEATURE, or INCREMENT keyword, then it is likely that an extra long line has been incorrectly wrapped and that the segment belongs at the end of the previous line. Make sure that you review your license key for these possible errors. If such an error is not corrected, the software will not be licensed.

**Note**
Be sure that the DAEMON line of the license file points to the idl_lmgrd program in the RSI-DIR/IDL_5.6/bin directory where RSI-DIR is the directory where you have installed your RSI software. If this is not the case, be sure to correct the license file path before proceeding.

5. **Save the license file.** Click Next to save the license.dat file in the RSI-DIR/license directory. If you have installed your software in a
directory other than the default, /usr/local/rsi, you must set the environment variables pointing to the license.dat file before starting your RSI software or the license manager. See instructions for setting the LM_LICENSE_FILE environment variable in “Set Up the IDL Environment” on page 92.

**Note**

If you receive a message that there is an existing license file, save the existing file under a different name before proceeding. While the new license usually contains information for all currently licensed products, save the old file as a safeguard against destroying license information. Run the license wizard again to save the new license file in the default location.

6. **Exit the licensing wizard.** Click Finish.

**Note**

If you have other software that uses Globetrotter Software’s FLEXlm license manager you may want to combine the RSI license file with the existing ones. See “Multiple Applications That Use The Same License Manager” on page 118 for instructions and options.

**Note**

RSI strongly recommends saving your license file with the default path and filename RSI-DIR/license/license.dat, for example, where RSI-DIR is /usr/local/rsi. If you put your license file in this directory, you do not have to redefine environment variables.

If you have saved the license file in a directory other than the default RSI-DIR/license/license.dat, you must set an environment variable pointing to the license.dat file before starting the license manager. See the section “Set Up the IDL Environment” on page 92 for instructions.

4. **Start the License Server**

This section describes how to start the license server. If you are using a node-locked or floating licenses, you must start the license server.
Note
If you are running only type MU (unlimited usage) licenses, as indicated on your license file’s INCREMENT line (indicated with 0 (zero) or “uncounted”), you do not need to start the license manager.

Once you entered the license key, start the license manager by completing the following steps:

1. **Set the IDL_DIR environment variable.** To set the IDL_DIR environment variable, enter the following:

   For C shell, or T shell (Mac OS X default):
   ```
   setenv IDL_DIR /RSI-DIR/idl_5.6
   ```

   For Korn shell:
   ```
   export IDL_DIR='/RSI-DIR/idl_5.6'
   ```

   where RSI-DIR is the main installation directory for your RSI software.

2. **Start the license server.** To start the license server, enter the following:

   ```
   RSI-DIR/idl_5.6/bin/lmgrd [-c license_path]
   ```

   where RSI-DIR is the directory where you have installed your RSI software, and license_path is the full pathname to the license file, including the license filename. The default license path is RSI-DIR/license/license.dat. If you have used this default location or have defined the LM_LICENSE_FILE environment variable (as described in “Define the Path to the License File or License Server” on page 115), it is not necessary to specify the -c license_path option.

   For information on other license manager functions, see “Working with the License Server” on page 112. If you receive an error message while trying to start the license manager, consult “License Manager Startup Troubleshooting” on page 121 for possible solutions to your problem.

Note
If you have more than a single FLEXlm license manager running on a server, conflicts may exist among the license managers. Before starting the license manager, see “Multiple Applications That Use The Same License Manager” on page 118 for more detailed information on customizing your license file.

Note
Starting the license manager requires no special privileges. Note the potential security ramifications of running the license manager from the root account, as it
can be started by any user. However, special privileges are required to shut down the license manager. See “Shutting Down The License Manager” on page 114 for more information.

5. Set Up the IDL Environment

Before you can run IDL, you must set up each user’s environment on the machine that will be running IDL. See “Setting Up the IDL Environment” on page 114 for instructions.
Running IDL

See “Running IDL on UNIX” on page 118 or “Running IDL on Macintosh” on page 119 for information on how to run IDL once your license is installed and your IDL environment has been set up.
Modifying the License File

The license file controls:

- Which products can run
- Which machines they can run on
- How many copies can run concurrently

The FEATURE lines of the license file determine which products are available. The SERVER lines define which machines the products run on. The number of copies of the product that can run concurrently is controlled by the number of license units available, as specified by either the FEATURE or INCREMENT lines.

Sample License Files

The following is an example of what a license file look like.

**An IDL License File**

The following example license file is built for the license server “hal”, which has the LMHostid “0000c09a23f0,” and the designated port number “1700”. This license has 5 floating licenses for UNIX machines.

The last line in the license file is the FEATURESET line, which ties all the FEATURE and INCREMENT lines together:

```
SERVER hal 0000c09a23f0 1700
DAEMON idl_lmgrd usr/local/rsi/idl_5.6/bin/idl_lmgrd
FEATURE idl idl_lmgrd 5.600 1-jan-0000 50 5BC6A081FA3009FA5673 \ 
    VENDOR_STRING="1234-1Acme Datawack Corp" ck=16
FEATURESET idl_lmgrd 96C31B1FB71B9E9
```

**Note**

The FEATURE line for the IDL floating license shows 50 license units. This is not an error. Each counted IDL license requires 10 license units on the FEATURE or INCREMENT line. If this field is set to zero, the line indicates an unlimited number of node-locked licenses. The number of license units is a platform-dependent scale factor times the number of licenses you own. For example, if you have 3 UNIX floating licenses, this field is set to 30.
Viewing or Modifying the License File

To access the text of your license file through the license wizard, complete the following steps:

Locating the License File

1. After installing RSI software, open the licensing wizard by changing to your RSI-DIR/idl_5.6/bin directory and typing rsilicense at the UNIX prompt.

2. Select Permanent and License to display the license text file window. If you have a file saved in the default location, RSI-DIR/license/license.dat, it will appear in the text window. If you have saved the file in another location, click Browse to find it.

Altering the License File

Only four data items in the license file can be modified by the user:

- hostnames (but not host IDs) on SERVER lines
- port numbers on SERVER lines
- pathnames on DAEMON lines
- options file pathnames on DAEMON lines (Note that it is not necessary to specify option file path names with FLEXlm v6 or later. IDL 5.6 for UNIX uses FLEXlm v6.1).

Warning

Changing license file lines other than those discussed below will invalidate your license file, causing your IDL installation to run only in Demonstration mode. Individually altering any FEATURE or INCREMENT lines with DAEMON name idl_lmgrd destroys the file.

If you have multiple vendors using FLEXlm license management software, see “Multiple Applications That Use The Same License Manager” on page 118 for more detailed information on customizing your license file.
Working with the License Server

Several license manager support utilities are supplied for controlling the operation of the license server. These commands are all found in the bin subdirectory of the IDL distribution as shell scripts.

Note
You must have your IDL environment set up before running any of these utilities. For more information, see “Set Up the IDL Environment” on page 92.

Note
To view a complete list of license manager utility commands, change to the RSI-DIR/idl_5.6/bin directory and type lmutil at the UNIX prompt.

Automatically Starting the License Manager at Boot Time

To have the license server automatically start every time your server is booted, you should add the following license manager startup command to the system startup script:

```
RSI-DIR/idl_5.6/bin/lmgrd [-c license_path]
```

for example

```
/usr/local/rsi/idl_5.6/bin/lmgrd $  
-c /usr/local/rsi/license/license.dat
```

(On some systems, you may need to enter a controlling script rather than change the system startup script.)

Although the general idea is the same for all UNIX systems, the exact details differ between platforms. In all cases, you should consult the documentation for your system. The guidelines below are intended to serve as a starting point.

Note
These systems all require modification of system files and/or directories to start the license manager. Such changes may be lost when you update the operating system. Therefore, you should keep notes on the changes made, so that you can properly customize new operating system releases. The following instructions may differ for your platform. For additional information, refer to your host operating system documentation or the man pages for init, rc0, rc2, and rc3.
IBM AIX

Using any text editor, add the startup command for the license manager to the end of the /etc/rc file.

Linux

Using any text editor, add the startup command for the license manager to the end of the /etc/rc.d/rc.local file.

Sun Solaris, SGI IRIX, HP-UX, and Compaq Tru64 UNIX

You must place a controlling script in a directory (usually /etc/init.d or /sbin/init.d) and create links to that script that are run at system startup and shutdown.

A template for the controlling script can be found in the file RSI-DIR/idl_5.6/bin/sys5_idl_lmgrd. Read this file for instructions that apply to your system. After customizing this script for your site, copy the file to the appropriate directory and create the links that are described in the file. For additional information, see the system administrator’s manual for your system or the man pages for init, rc0, rc2, and rc3.

Note

These instructions cover most situations. For information about license manager error messages or for permissions needed to run and shut down the license manager, see the “License Manager Startup Troubleshooting” on page 109 or “Working with the License Server” on page 96.

Creating a License Manager Log File

The license manager writes a log of its activities to its standard output. If you don’t want to keep a log, you can redirect the standard output to the null device (/dev/null) by starting the license manager with the command:

```
RSI-DIR/idl_5.6/bin/lmgrd > /dev/null
```

It is also possible to direct the log to the system console with the command:

```
RSI-DIR/idl_5.6/bin/lmgrd > /dev/console
```

If you wish to keep a permanent log file, you should choose a location on your system where a growing log won’t cause disk space problems. On Sun systems, the /var/adm directory is a reasonable choice.
Shutting Down The License Manager

The `lmdown` program initiates a shutdown of all license managers by sending a message to every license manager asking it to shut down. The license managers write out their last messages to the log file, close the file, and exit. All licenses which have been given out by those managers are rescinded, so that the next time an RSI software process goes to verify its license, it will not be valid.

To run `lmdown`, change to your `RSI-DIR/idl_5.6/bin` directory and type `lmdown` at the UNIX prompt following the syntax below:

```
lmdown [-c license_file] [-q]
```

Option arguments include `-c` which defines the path to your `license.dat` file and `-q` which runs `lmdown` in “quiet mode”. If the `-q` switch is not specified, `lmdown` asks for confirmation before asking the license managers to shut down. If this switch is specified, `lmdown` does not ask for confirmation.

Security note: Unauthorized use of the `lmdown` command can be disruptive because when the license manager shuts down, all current RSI software product sessions are terminated. You should ensure that the file access modes on your system are sufficiently restrictive. We recommend setting the permissions for `lmdown` with the following UNIX command:

```
cchmod 500 RSI-DIR/idl_5.6/bin/lmdown
```

Reclaiming an Unused License

If a licensed user is running IDL when the machine crashes, the license that was in use may fail to be returned to the server. In this case, the license is not available to other users. The `lmremove` program allows the system administrator to remove a single user’s license for a specified feature and allows the license to return to the pool of available licenses.

**Warning**

Do not use `lmremove` to return a license that is being used by an active IDL session. Use only to reclaim licenses from IDL sessions that are no longer active.

To free a license, you need to first gather information using the `status`, `lmstat`, command.

To run `lmstat`, change to your `RSI-DIR/idl_5.6/bin` directory and type:

```
lmstat -A | more
```
This shows the status of license managers as well as checked-out licenses. For example the following line shows user ‘robin’ has a license for IDL 5.6 checked out from the server ‘hal7’ which is being displayed on the host ‘josh’:

robin hal7 josh (v5.6) (hal7/1700/395), start Mon 10/12 4:34, # licenses

The format of this line is:

user host display (version) (host/port/license_handle), start_date, # of available licenses

If the license held by user ‘robin’ needs to be freed, make note of the user, host, and display values, and then remove the license with the following lmremove syntax:

lmremove idl robin hal7 josh

where  idl is the feature,  robin is the  user,  hal7 is the  host, and  josh is the display. Other feature values for RSI products appear in the table below. You can check to make sure the license was freed by typing the following at the UNIX command prompt:

lmstat -A | more

The license you just removed should no longer appear in the list of licenses checked out. See the following table for a list of lmremove feature values.

<table>
<thead>
<tr>
<th>RSI Software Product</th>
<th>Feature Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDL</td>
<td>idl</td>
</tr>
<tr>
<td>IDL Runtime</td>
<td>idl_rt</td>
</tr>
<tr>
<td>IDL with the Wavelet Toolkit</td>
<td>idl_wavelet</td>
</tr>
<tr>
<td>IDL DataMiner</td>
<td>idl_dm</td>
</tr>
<tr>
<td>IDL MPEG</td>
<td>idl_mpeg</td>
</tr>
<tr>
<td>Right to Distribute</td>
<td>devkit</td>
</tr>
<tr>
<td>ENVI</td>
<td>envi</td>
</tr>
<tr>
<td>ION Script</td>
<td>ion_script</td>
</tr>
<tr>
<td>ION Java</td>
<td>ion_java</td>
</tr>
<tr>
<td>RiverTools</td>
<td>idl_rivertools</td>
</tr>
</tbody>
</table>

Table 5-1: Feature Values for lmremove
Checking the License Manager Status

The `lmstat` program provides information about the status of the server nodes, license managers, and currently checked out licenses. To run `lmstat`, change to your `RSI-DIR/idl_5.6/bin` directory, and enter:

```
  lmstat [-a] [-A] [-c license_file] [-l [regular_expr]]
          [-s [server]]
```

Optional flags for `lmstat` are shown in the following table.

<table>
<thead>
<tr>
<th>Optional Flags for lmstat</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>-a</strong></td>
</tr>
<tr>
<td><strong>-A</strong></td>
</tr>
<tr>
<td><strong>-c license_file</strong></td>
</tr>
<tr>
<td><strong>-l [regular_expression]</strong></td>
</tr>
<tr>
<td><strong>-s [server]</strong></td>
</tr>
</tbody>
</table>

Table 5-2: Optional Flags for lmstat

Obtaining a Host ID

The `lmhostid` program calls the license manager version of `gethostid` and displays the results. To run `lmhostid`, change to the directory,
RSI-DIR/idl_5.6/bin, and type lmhostid at the UNIX prompt. The output of lmhostid looks like this:

```
lmhostid - Copyright (C) 1989-1999 Globetrotter Software, Inc.
The FLEXlm host ID of this machine is "8002add0"
```

**If You Encounter Errors**

If the license manager gives an error message when starting, see “License Manager Startup Troubleshooting” on page 109.
Multiple Applications That Use The Same License Manager

IDL’s network license management facility is provided by Globetrotter’s FLEXible License Manager (FLEXlm). Since this license manager is not unique to IDL, the possibility exists that you will need to run software from two or more software vendors that use FLEXlm. In this case, the potential for license server conflict exists. There are two cases to be considered:

- All products and product license managers are installed on the same server.
- The products and product license managers use different servers.

All Products Use the Same Set of Server Nodes

If an RSI product and other vendor product(s) using FLEXlm license management software are all installed on the same server machine, the solution is simple. Combine the license files as described below.

**Note**

Note that you must shut down the license server before editing the license file.

Combining License Files

After shutting down the license server, use a text editor to alter a single license file. In this single license file, combine all license files by taking the SERVER lines from any one license file, and adding all the DAEMON, FEATURE, FEATURESET, and INCREMENT lines from all of the license files.

Place copies of this combined license file in the locations required by the various software vendors. Alternatively, a single copy of the license file can be located in any convenient location, in which case each client machine must set the LM_LICENSE_FILE environment variable to point to it.

After saving the license files in the appropriate locations, restart the license manager with the most recent version of lmgrd that you have installed. (IDL 5.6 uses FLEXlm v6.1). If an older version of lmgrd is used, the license manager from the product with a more recent lmgrd will not operate correctly.
The Products Use Different Servers

If the products use different servers, a local or shared network installation of the
product license file is required on each client machine. This copy of the license file
directs the request for a license to the proper server. You will also need to set the
existing **LM_LICENSE_FILE** variable to include the new product’s license file path.

For example, if you have an existing product named “otherapp” residing in the
“home” directory, the **LM_LICENSE_FILE** environment variable would be as
follows:

For C shell, or T shell (Mac OS X default):

```
setenv LM_LICENSE_FILE /home/otherapp/license.dat
```

To add an RSI software product license file, add it to the existing
**LM_LICENSE_FILE** variable by separating the new application’s license path from
the existing one with a colon as follows:

For C shell, or T shell (Mac OS X default):

```
setenv LM_LICENSE_FILE
/home/otherapp/license.dat:RSI-DIR/license/license.dat
```

**RSI-DIR** is the installation directory for your RSI software product.

Tip

Restart the license manager with the most recent version of *lmgrd* that you have
installed. The version number of *lmgrd* is displayed when it is started. If an older
version of *lmgrd* is used, the license manager daemon from the product with a
more recent *lmgrd* will not operate correctly.
Troubleshooting

If an RSI software product runs in seven-minute demonstration mode after you have attempted to license the product, follow the appropriate suggestions below and try running the software again. If you see errors from the license manager itself, turn to “License Manager Startup Troubleshooting” on page 109.

1. **Is the proper executable file (idl) in your command search path?**

   The UNIX command:
   ```
   which idl
   ```
   will tell you if it is in your command search path and where it is. You can verify that the search path is the problem by executing IDL directly. If the command:
   ```
   RSI-DIR/idl_5.6/bin/idl
   ```
   runs IDL, you know that the search path is to blame.

2. **Are the file permissions correct?**

   If you receive the error message “Permission denied” when you try to run IDL, check the permissions set on all the executables. They should have execute permission set for all categories. Set execute permissions for IDL by entering:
   ```
   chmod ugo+x RSI-DIR/idl_5.6/bin/*
   ```

3. **Does IDL know the location of the main IDL directory?**

   The environment variable IDL_DIR must be defined to the path of the IDL directory. Enter the following UNIX command:
   ```
   echo $IDL_DIR
   ```
   IDL_DIR should be set to `RSI-DIR/idl_5.6`. If not, you probably have not run the `idl_setup` or `idl_setup.ksh` file. To set the variable for IDL_DIR, enter the following:
   For C shell, or T shell (Mac OS X default):
   ```
   setenv IDL_DIR RSI-DIR/idl_5.6
   ```
   For Korn shell:
   ```
   export IDL_DIR='/RSI-DIR/idl_5.6'
   ```
4. Is the license manager running?

The `lmstat` license manager utility provides information on the status of the license manager. Enter:

```
RSI-DIR/idl_5.6/bin/lmstat
```

If you receive the following message:

```
License server status:
  name: cannot connect to license server (Connection refused)
Vendor daemon status (on name):
  idl_lmgrd : cannot connect to license server (Connection refused)
```

the server is not running correctly.

5. Stop and restart the license manager.

Exit IDL and stop the license manager, then restart it, directing the output of the license manager to a file. Enter:

```
RSI-DIR/idl_5.6/bin/lmdown
```

Check to make sure that all the license manager processes have shut down with a command like:

```
ps -ef | grep lm
```

or

```
ps -aux | grep lm
```

If there are any license manager processes still running, use the `kill` command to stop them (do not use the -9 option for `kill`). Restart the license manager with the following command:

```
RSI-DIR/idl_5.6/bin/lmgrd > logfile
```

Examine the resulting file `logfile` for error messages and refer to “License Manager Startup Troubleshooting” on page 121.

6. Is the LM_LICENSE_FILE environment variable set to the license file of another application?

Enter the command:

```
echo $LM_LICENSE_FILE
```

to see the current definition of the environment variable. If this environment variable points to some other license file, you will need to unset it prior to starting IDL by entering:
unsetenv LM_LICENSE_FILE

For Korn shell:
unset LM_LICENSE_FILE

If you have used a different path than the default location, make sure that LM_LICENSE_FILE points to that location.

7. Is the license manager available from your machine?

If IDL displays the following error message at startup:

LICENSE MANAGER: cannot connect to license server.

make sure that you can telnet to the server machine. If you can remotely log in to the server machine, make sure that the license manager is running on that machine.

8. Has your license file been copied correctly?

If IDL displays the following error message at startup:

% LICENSE MANAGER: encryption code in license file is inconsistent.

some of the encrypted information in the license file is not correct. This can involve the SERVER hostid, the DAEMON name, and any character on the FEATURE line.

Examine your license file and correct the FEATURE line so that it exactly matches the one sent to you by RSI. Check for capitalization and spaces. Shut down the license manager by entering:

RSI-DIR/idl_5.6/bin/lmdown

and restart by entering:

RSI-DIR/idl_5.6/bin/lmgrd

9. Is the license manager using the correct license file?

If IDL displays the following error message at startup:

LICENSE MANAGER: no such feature exists.
LICENSE MANAGER: license file does not support this feature.

the license manager may be using the wrong license file. Reset the LM_LICENSE_FILE environment variable to point to IDL’s license file using the command:

setenv LM_LICENSE_FILE RSI-DIR/license/license.dat
See Defining the LM_LICENSE_FILE environment variable in “Set Up the IDL Environment” on page 92 for more information.

10. Does the license file contain the correct hostname?

If IDL displays the following error message at startup:

% LICENSE MANAGER: cannot find SERVER hostname in network database.

the hostname in the license file does not agree with the actual hostname for the server, or cannot be accessed from the client node. Edit the license file and correct the hostname. The hostname can be found in the /etc/hosts file located on the network server.

11. Are network permissions set properly?

If IDL displays the following message at startup, except when run from the root account:

% LICENSE MANAGER: invalid host.

make sure that the ethernet device (usually /dev/lan0) has rw permission for owner, group and other. It probably just has rw permission for owner (root). Also, make sure that the /var/tmp directory has rw permissions.

This error occurs most often on HP-UX systems. You can use /etc/lanscan to check for the name of the ethernet device. This is the item under the heading “NameUnit”.

12. Is the license file in the correct location and are its permissions set correctly?

If you receive one of the following three error messages, IDL is unable to access the license.dat file:

% Trial version expired.
% Machine not licensed for IDL. Entering 7 minute Demo mode. This Demo mode is for short-term product evaluation purposes only.

% Machine not licensed for IDL. Entering 7 minute Demo mode. This Demo mode is for short-term product evaluation purposes only.

% Unexpected validation error.
% Machine not licensed for IDL. Entering 7 minute Demo mode. This Demo mode is for short-term product evaluation purposes only.
Check the permissions on the license.dat file. All users need read permission. Also make sure the license.dat filename is spelled correctly. If you are using the environment variable LM_LICENSE_FILE, make sure that the full path and filename of the license.dat file are set correctly. See “Set Up the IDL Environment” on page 92 for more information.

13. Search the RSI Technical Support Library

Go to www.RSInc.com/services/search.cfm and select the following for more information on troubleshooting node-locked and floating licensing:

- Product: IDL
- Platform: UNIX or Mac OS X
- Category: LICENSING
- Functional Area: LICENSING - FLEXlm

14. Contact RSI Technical Support

If you are still having problems licensing, see “Contacting RSI” on page 10 for information on how to contact Technical Support.
License Manager Startup Troubleshooting

If the license manager gives an error message when starting, find the error message below and follow the instructions to eliminate the error.

1. Invalid Server Hostname

   ```
   date time (lmgrd) "Hostname1": Not a valid server hostname, exiting.
   date time (lmgrd) Valid server hosts are: "Hostname2"
   ```

   In spite of the error message, Hostname1 is the hostname of the server that probably should be in the license file, while Hostname2 is the incorrect hostname currently in the license file. Edit your license file to contain the correct hostname.

2. Inconsistent Encryption Code

   ```
   date time (idl_lmgrd) Inconsistent encryption code for idl
   ```

   There is a problem with the information on the FEATURE or INCREMENT line of the license file. It has not been copied correctly from the fax or e-mail message. Make sure that the usage of capitalization and spaces is exactly as in the message. Finally, check to make sure that long lines in the license file have not been inadvertently wrapped to a new line. (Refer to “Viewing or Modifying the License File” on page 131 for examples of the correct license file format.)

3. No Features to Serve

   ```
   date time (idl_lmgrd) No features to serve!
   ```

   There are no valid FEATURE or INCREMENT lines. This is most commonly due to the “inconsistent encryption code” error described above.

4. Retrying Socket Bind and Cannot Establish Lock

   ```
   date time (lmgrd) Retrying socket bind (address in use: port 1700)
   ```

   An attempt has been made to start the license manager when it was already running. This often happens when the license file contains a mistake, the mistake is corrected, and the license manager is started again before the first attempt has been shut down or killed. Only one instance of the license manager can be running on a machine with reference to any RSI product license file at any one time. There may also be some other software product using the default port number, 1700.
If this is the case, the problem may be resolved by issuing the `lmdown` command multiple times and then restarting the license manager again. To shut down the license manager, you can issue the following commands (from a C shell):

```
RSI-DIR/idl_5.6/bin/lmdown -c RSI-DIR/license/license.dat
```

The `lmdown` command should be repeated until the utility indicates that the license manager is not running. Then restart the license manager. See “Install the License Server” on page 87.

5. No Such File or Directory

```
license daemon: exec1 failed: .../idl -T host 2.40 3 -c
license daemon: system error code: No such file or directory
```

The path on the DAEMON line of the license file is incorrect. It should point to the bin subdirectory of the IDL distribution. Edit the license file and correct the DAEMON line.

6. No “License” Server Found

```
date time (lmgrd) No "license" service found.
```

This error means that no TCP/IP service port number is specified or no TCP/IP service is available.

Check for the existence of the `/etc/services` file. Make sure that the file contains the following line:

```
tcpmux 1/tcp
```

7. Cannot Find License File

```
license manager: can't initialize: cannot find license file
(No such file or directory)
date time (lmgrd) Using license file "filename"
```

The license manager cannot find the `license.dat` file. Either the `license.dat` file is not in the default location or the file specified in the environment variable `LM_LICENSE_FILE` is incorrect. See “Set Up the IDL Environment” on page 92. Also, make sure that the filename `license.dat` is spelled correctly and that you have read permission for the `license.dat` file.
8. Cannot Read License File

license manager: can't initialize: cannot read license file
(Permission denied)

The permissions are set incorrectly on the license.dat file. Set the file to read
permission for all users. For example, use the command:

```
chmod 444 license.dat
```

9. Wrong Hostid

```
date time (idl_lmgrd) Wrong hostid, exiting (expected xxxx, got xxxx)
date time (lmgrd) Please correct problem and restart daemons
```

The permissions are set incorrectly on the ethernet device. This is a common problem
on HP-UX systems. Set read-write permission on the ethernet device (/dev/lan0)
with the command:

```
chmod 666 /dev/lan0
```

Shutdown the license manager if it is still running and then restart it.

10. Path Not Found

```
lmgrd: PATH/bin.platform/lmgrd: not found.
```

This error indicates that the IDL directory is not in a standard location and that the
environment variable IDL_DIR is not set to the actual IDL directory. There are
several solutions to the problem:

- Change directories to the IDL directory and issue the following command:
  `bin/lmgrd`
- Set the environment variable IDL_DIR to point to the main IDL directory and
  then execute the lmgrd startup command.

Change directories to `RSI-DIR/idl_5.6/bin`. Make a copy of the `lmgrd` script:

```
cp lmgrd lmgrd.bak
```

Open the `lmgrd` script with an editor. Verify that the INSTALL_DIR environment
variable is defined as `RSI-DIR`. For example, if you have installed in the default
path, this should be defined as `/usr/local/rsi`. 
11. Check the Globetrotter Web Site.

The Globetrotter Web site contains on-line documentation and an excellent FLEXlm FAQ. This information can be helpful when trying to combine licenses from different vendors. See the following Web pages:

Globetrotter home page: http://www.globetrotter.com

FLEXlm FAQ: http://www.globetrotter.com/flmfaq.htm

If you continue to have problems, see “Contacting RSI” on page 10 for technical support.
Chapter 6:
Setting Up and Running IDL on UNIX/Macintosh

This chapter covers the following topics:

- Setting Up the IDL Environment .......... 114
- Running IDL on Macintosh ............... 119
- Running IDL on UNIX .................... 118
Setting Up the IDL Environment

Before you can run your RSI product on a UNIX or Macintosh platform, you must set up each user’s environment on the machine that will be running it. This consists of the following tasks that each user will need to complete:

- Defining the required IDL environment variables and aliases.
- Defining the required ION environment variables and aliases.
- Defining the path to the license file or license server.

Define IDL Environment Variables and Aliases

A setup script has been provided which will set all required environment variables and aliases for IDL. RSI suggests that you modify either the `.cshrc` (.tcshrc for Mac OS X) or `.profile` file for each user who will be accessing IDL so that these settings are automatically executed whenever a user logs in.

To modify your `.cshrc`, `.tcshrc` or `.profile` file, complete the following steps:

1. **Modify each user’s `.cshrc`, `.tcshrc` or `.profile` file using any plain text editor.**

   For C shell, or T shell (Mac OS X default), have each user add the following line to their `.cshrc` or `.tcshrc` file:
   
   ```
   source RSI-DIR/idl_5.6/bin/idl_setup
   ```

   For Korn shell, have each user add the following line to their `.profile` file:
   
   ```
   . RSI-DIR/idl_5.6/bin/idl_setup.ksh
   ```

   where `RSI-DIR` is the main installation directory for your RSI product.

2. **Execute your `.cshrc`, `.tcshrc` or `.profile` file.** Log out and log back in to execute the `.cshrc`, `.tcshrc` or `.profile` file or execute the file from the home directory using one of the following commands:

   For C shell, or T shell (Mac OS X default):
   
   ```
   source .cshrc, or source .tcshrc
   ```

   For Korn shell:
   
   ```
   .profile
   ```
Define ION Environment Variables and Aliases

If you have installed ION, you will need access to ION Service utilities as well as IDL-related environment variables and aliases as well as defining the ION_DIR environment variable to point to the main ION directory. A script called ion_setup (ion_setup.ksh for Korn shell) is located in the RSI_DIR/idl_5.6/products/ion_1.6/bin directory. This script also allows you to use the rsilicense command, which starts the licensing wizard and the ionman command, which opens the ION Online Manuals in Adobe Acrobat Reader. To have your environment automatically set up upon login, do the following:

1. For C-shell or T shell (Mac OS X default) users, add the following line to your .cshrc files:
   
   ```bash
   source RSI-DIR/idl_5.6/products/ion_1.6/bin/ion_setup
   ```

   For Korn shell users add the following line to your .profile files:

   ```bash
   . RSI-DIR/idl_5.6/products/ion_1.6/bin/ion_setup.ksh
   ```

   `RSI-DIR` is the name of the main installation directory you selected previously (the default is /usr/local/rsi).

2. Execute your .cshrc, .tcshrc or .profile file. Log out and log back in to execute the .cshrc, .tcshrc or .profile, or execute the file from the home directory using one of the following commands:

   For C-shell:

   ```bash
   source .cshrc, or source .tcshrc
   ```

   For Korn shell:

   ```bash
   . .profile
   ```

Define the Path to the License File or License Server

To allow access to RSI software for both node-locked and floating licenses, the machines on which you are running IDL must have access to both the license file or the license manager.

**Note**

Since Web Servers do not read any system environment variables, you cannot use the LM_LICENSE_FILE environment variable to point to where you have located your license file for use with ION. When licensing ION, you must place your license file in the default location RSI-DIR/license/license.dat where RSI-DIR is the name of the main installation directory you selected to install ION Java.
On UNIX, if you have a network license that you wish your ION installation to use, you can copy the network license file to the default location `RSI-DIR/license/license.dat` on the machine on which you are running ION.

**Node-locked License**

If you are installing a node-locked license and you saved the license file in a place other than the default (`/usr/local/rsi/license/license.dat`), you must define the path to the license file. RSI suggests that you modify either the `.cshrc` (.tcshrc for Mac OS X) or `.profile` file for each user who will be accessing IDL so that these settings are automatically executed whenever a user logs in.

1. **Modify each user’s `.cshrc`, `.tcshrc` or `.profile` file using any plain text editor.** You must define the UNIX environment variable for `LM_LICENSE_FILE` to point to the path to the license file. For example, if you save your license file as:
   
   `/myhome/license.dat`

   in the `.cshrc`, `.tcshrc` or `.profile` file, define the `LM_LICENSE_FILE` variable as follows:

   For C shell, or T shell (Mac OS X default):
   
   ```
   setenv LM_LICENSE_FILE /myhome/license.dat
   ```

   For Korn shell:
   
   ```
   export LM_LICENSE_FILE="/myhome/license.dat"
   ```

2. **Execute your `.cshrc`, `.tcshrc` or `.profile` file.** Log out and log back in to execute the `.cshrc`, `.tcshrc` or `.profile` file or execute the file from the home directory using one of the following commands:

   For C shell, or T shell (Mac OS X default):
   
   ```
   source .cshrc, or source .tcshrc
   ```

   For Korn shell:
   
   ```
   . .profile
   ```

**Floating Licenses**

You must define the path to the license server in each user’s environment that will be running IDL. To do this, you must define the `LM_LICENSE_FILE` environment variable. RSI suggests that you modify either the `.cshrc` (.tcshrc for Mac OS X) or `.profile` file for each user who will be accessing IDL so that these settings are automatically executed whenever a user logs in.
1. **Modify each user’s** `.cshrc`, `.tcshrc` **or** `.profile` **file using any plain text editor.** You must define the UNIX environment variable for LM_LICENSE_FILE to point to the server and port of the machine running the license server. The syntax for the defining the environment variable is:

```bash
port@host
```

For example, if you are running the license server on a machine named “hal” with a port of 1700, then you would enter:

For C shell, or T shell (Mac OS X default):

```bash
setenv LM_LICENSE_FILE 1700@hal
```

For Korn shell:

```bash
export LM_LICENSE_FILE='1700@hal'
```

2. **Execute your** `.cshrc`, `.tcshrc` **or** `.profile` **file.** Log out and log back in to execute the `.cshrc`, `.tcshrc` or `.profile` file or execute the file from the home directory using one of the following commands:

For C shell, or T shell (Mac OS X default):

```bash
source .cshrc, or source .tcshrc
```

For Korn shell:

```bash
. .profile
```

You can change the port number by modifying the license file. For more information, see “**Modifying the License File**” on page 130.
Running IDL on UNIX

You can now start IDL or any of the following executables by entering one of the following commands:

- For IDL without its Motif GUI environment, enter `idl` at the system command prompt. IDL command line access is available at the UNIX prompt.
- For IDL with a GUI environment, enter `idlde` at the system command prompt. This starts the IDL Development Environment.

All available commands are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>idl</td>
<td>Start IDL in command line access mode.</td>
</tr>
<tr>
<td>idlde</td>
<td>Start IDL Development Environment.</td>
</tr>
<tr>
<td>rsilicense</td>
<td>Starts the licensing wizard.</td>
</tr>
<tr>
<td>idldemo</td>
<td>Starts the IDL Demo Applications. You can also type <code>demo</code> at the IDL prompt after you have started IDL.</td>
</tr>
<tr>
<td>idlman, idlhelp</td>
<td>Start the IDL and ION online manuals. This requires Adobe Acrobat Reader to be installed on your system.</td>
</tr>
</tbody>
</table>

Table 6-1: IDL Startup Commands

Note

If these commands do not produce the expected results, you need to set IDL environment aliases. See “Setting Up the IDL Environment” on page 114.
## Running IDL on Macintosh

IDL 5.6 for MacOS X can only be run from a UNIX X-Windows prompt. In order to obtain an X-Windows prompt, it is necessary to start the OroborOSX window manager.

### 1. Start OroborOSX

1. Navigate to the OroborOSX installation folder.
2. Double-click the **OroborOSX** icon. OroborOSX launches XDarwin and displays a UNIX X-Windows command line in an OS X window.

### 2. Start IDL

You can now start IDL or any of the following executables by entering one of the following commands at the command line:

- For IDL without its Motif GUI environment, enter `idl` at the system command prompt. IDL command line access is available at the UNIX prompt.
- For IDL with a GUI environment, enter `idlde` at the system command prompt. This starts the IDL Development Environment.

All available commands are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>idl</td>
<td>Start IDL in command line access mode.</td>
</tr>
<tr>
<td>idlde</td>
<td>Start IDL Development Environment.</td>
</tr>
<tr>
<td>rsilicense</td>
<td>Starts the licensing wizard.</td>
</tr>
<tr>
<td>idldemo</td>
<td>Starts the IDL Demo Applications. You can also type <code>demo</code> at the IDL prompt after you have started IDL.</td>
</tr>
<tr>
<td>idlman, idlhelp</td>
<td>Start the IDL and ION online manuals. This requires Adobe Acrobat Reader to be installed on your system.</td>
</tr>
</tbody>
</table>

*Table 6-2: IDL Startup Commands*
Note

If these commands do not produce the expected results, you need to set IDL environment aliases. See “Setting Up the IDL Environment” on page 114.
You can customize IDL license management by creating a license manager options file. This file allows you to:

- Reserve licenses for specified users or groups of users.
- Allows or disallows the use of IDL by certain users.
- Control what events are recorded in the log file.

To customize the license manager, create an options file in a text editor as described in the following section. See “Sample Options Files” on page 125 for examples.
Creating an Options File

Use a text editor to create an options file. For RSI products, the options file must be named `idl_lmgrd.opt` and saved in the same directory as `license.dat`. The default location in which to save the options file is the `RSI-DIR/license` directory.

**Note**
Any time the options file is modified, the license manager must be stopped and restarted before the changes will take effect.

Use the following conventions when creating an options file:

- Specify each option on a separate line.
- Each line must begin with one of the keywords specified in the following table. See the following section “Options File Keywords” for a list of available keywords.
- Limit the length of each line to less than 2048 characters. You can use the backslash (\) as a line continuation character if you need more than 2048 characters.
- All elements of the options file are case sensitive so users and groups must be correctly and consistently identified.
- Lines beginning with the pound sign (#) are ignored and can be used as comments.

**Options File Keywords**

The following table describes the available keywords to use when creating an options file:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXCLUDE</td>
<td><code>EXCLUDE feature type type_name</code></td>
<td>Can exclude user, group, host, or host_group from using IDL. EXCLUDE takes precedence over INCLUDE statements.</td>
</tr>
<tr>
<td></td>
<td><code>EXCLUDE idl USER bob</code></td>
<td>Excludes user “bob” from using IDL.</td>
</tr>
</tbody>
</table>

*Table 6-3: Options File Keywords*
### Appendix A: Customizing Your Floating Licenses

#### Installing and Licensing IDL 5.6

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| EXCLUDEALL | EXCLUDEALL type type_name  
             | EXCLUDEALL GROUP misfit                                                 | Excludes the group misfit from using any IDL feature.                        |
|           |                                                                         | Implicitly allows all except “misfits” to access all features of IDL.       |
| GROUP     | GROUP group user_list                                                  | Defines a list of users as a group to be used with other keywords such as INCLUDE or EXCLUDE. |
|           | GROUP visitor sam kate                                                | Defines users “sam” and “kate” as comprising the group “visitor”.            |
| HOST_GROUP| HOST_GROUP group host_list                                             | Defines a list of hosts as a group to be used with other keywords such as INCLUDE or EXCLUDE. |
|           | HOST_GROUP main hal sam                                               | Defines hosts “hal” and “sam” as the group “main”.                           |
| INCLUDE   | INCLUDE feature type type_name  
             | INCLUDE idl GROUP visitor                                             | Includes only specifically identified users or groups. All others are implicitly outside of this group, and denied access. |
|           |                                                                         |                                                                             |
| INCLUDEALL| INCLUDEALL type type_name  
             | INCLUDEALL GROUP research                                              | Specifies users or groups allowed use of all IDL features.                   |
|           |                                                                         |                                                                             |
| LINGER    | LINGER feature seconds  
             | LINGER idl 20                                                          | Causes licenses to be held by the license manager for a specific amount of time after a user exits IDL. Rarely used. |
|           |                                                                         |                                                                             |

Table 6-3: Options File Keywords (Continued)
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAX</td>
<td>MAX #lic feature type type_name</td>
<td>Limits usage of a feature among users or groups.</td>
</tr>
<tr>
<td></td>
<td>MAX 10 compile GROUP research</td>
<td>Allows only a single user in the research group to use the compile feature at one time.</td>
</tr>
<tr>
<td>NOLOG</td>
<td>NOLOG event_type</td>
<td>A separate NOLOG line is needed to turn off logging of events including IN, OUT, DENIED, and QUEUED.</td>
</tr>
<tr>
<td></td>
<td>NOLOG DENIED</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOLOG QUEUED</td>
<td></td>
</tr>
<tr>
<td>REPORTLOG</td>
<td>REPORTLOG report_log _path</td>
<td>The “+” indicates that the file is to be appended instead of being over-written each time the manager is started.</td>
</tr>
<tr>
<td></td>
<td>REPORTLOG +RSI\license</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Specifies the reportlog file path.</td>
<td></td>
</tr>
<tr>
<td>RESERVE</td>
<td>RESERVE #lic feature type type_name</td>
<td>Ensures that an IDL license will always be available to a specified user or group.</td>
</tr>
<tr>
<td></td>
<td>RESERVE 10 idl USER sam</td>
<td>Reserves a single IDL license for the user “sam”.</td>
</tr>
</tbody>
</table>

*Table 6-3: Options File Keywords (Continued)*
Sample Options Files

To Reserve Licenses for a Group

The following example shows how to define and reserve a number of licenses for a group of users, and tells the license manager not to log denied requests. Each copy of IDL requires 10 license units on a Workstation-class machine. Comment lines begin with #.

```plaintext
# reserve 5 IDL licenses for the research group
RESERVE 50 idl GROUP research
# define the users in the research group
GROUP research josh hal bob kate beth
# exclude anyone on a computer with the name main
EXCLUDE idl HOST main
# do not log license denials
NOLOG DENIED
```

Note
When using INCLUDE or EXCLUDE, anyone not specifically mentioned on a list is implicitly excluded or included. For example, in the above file, everyone who is not working on a computer named “main” would be allowed to access IDL. An EXCLUDE statement takes precedence over an INCLUDE statement. If the user “josh” was working on a computer named “main,” he would not be able to access IDL even though there is a license reserved for him.

To Reserve Licenses for Individuals

The following options file reserves licenses for individuals in the group defined above. If you have a group of 10 people, you can specify that a license or licenses will always be available to certain users by using the RESERVE keyword in an options file. The NOLOG line pertains to the IDL QUEUE command which allows a user to wait for an IDL license instead of entering demonstration mode when a counted license is unavailable. It tells the log file not to record any queue events.

```plaintext
# reserve one license for "kate"
RESERVE 10 idl USER kate
# reserve one license for "josh"
RESERVE 10 idl USER josh
# reserve 3 licenses for "hal"
RESERVE 30 idl USER hal
# do not log queue events
NOLOG QUEUED
```
Appendix B:
Running Older Versions of IDL

Running Older Versions of IDL Concurrently with IDL 5.6

In many cases, it is possible to run older versions of IDL concurrently with the most recent version. If a FEATURE line has the version number 5.600, for example, it will allow IDL 5.6 and all earlier versions of IDL to run. In some cases, new license manager capabilities such as the INCREMENT line may prevent an older versions of IDL from working with the latest version of the license manager.

Start the Latest Version of the License Manager

In general, it is important to start the license manager from the latest IDL distribution and use the same license file for the older IDL distribution. The license manager should only be started once, from the new distribution. It should not be started from an old IDL distribution.
Using IDL Version 5.x with the IDL Version 5.6 License Manager

The license manager from IDL version 5.6 will support IDL 4.0, 5.0, 5.1, 5.2, 5.3, 5.4 and 5.5 clients. No modifications to the IDL 5.6 license file are necessary to run IDL 4.0 and IDL 5.x concurrently with IDL 5.6.